
VT LAN 40 Terminal
Quick Start and Operating
Information
Part Number: EK-L40AA-UG. A01

Digital Equipment Corporation
Maynard, Massachusetts



March 1995

Digital Equipment Corporation makes no representations that the use of its products in the manner
described in this publication will not infringe on existing or future patent rights, nor do the
descriptions contained in this publication imply the granting of licenses to make, use, or sell
equipment or software in accordance with the description.

 Digital Equipment Corporation 1995. All rights reserved.

FCC ID: A09-VTGYX

Note:  The equipment described in this manual has been tested and found to comply with the limits for
a Class B digital device, pursuant to Part 15 of the FCC rules.  These limits are designed to provide
reasonable protection against harmful interference in a residential installation.  Any changes or
modifications made to this equipment may void the user's authority to operate this equipment.

This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used
in accordance with the instructions, may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If this
equipment does cause harmful interference to radio or television reception, which can be determined
by turning the equipment off and on, the user is encouraged to try to correct the interference by one or
more of the following measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver.

• Connect the equipment into an outlet on a circuit different from that to which the receiver is

connected.

• Consult the dealer or an experienced radio/TV technician for help.

DEC, VT, DECnet, LAT, ReGIS, VT52, VT100, VT220, VT320, VT420, OpenVMS, ULTRIX, SSU,
VAX, and the DIGITAL logo are trademarks of Digital Equipment Corporation.

IBM is a registered trademark of the International Business Machines Corporation. Novell and
NetWare are registered trademarks of Novell, Inc. Postscript is a registered trademark of Adobe
Systems, Inc. Tektronix is a registered trademark of Tektronix, Inc. UNIX is a registered trademark of
Novell, Inc., licensed exclusively through X/Open Company, Ltd. Windows is a trademark of
Microsoft Corporation. The Energy Star emblem does not represent EPA endorsement of any product
or service. A monitor with a ferrite core on the video line may be used with the VT LAN40.



Quick Start

This part of the guide helps you to quickly start one or more sessions with a host
computer from your VT LAN40 terminal.  If you are unfamiliar with how to use
Windows and the mouse, see Appendix A for detailed information and
procedures.

How to Start Your VT LAN40 Terminal
1. Turn your terminal and your monitor on.

• If you have used your terminal before, use the procedures in the next
section.

• If this is the first time you are turning your terminal on, the Configure
Keyboard dialog box appears.

2 Select the keyboard you are using.

3. Choose OK.

A message box appears to prompt you about configuring your network.
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Serial and LAT communications are already configured.
Do you wish to configure DECnet or TCP/IP communications now?

If you select 'No' now, you may configure the network at a later time.

Configure Network

4. You have two choices for configuring the network:

• If you are not connecting to a network or you are using a LAT network
connection, choose the 'No' button and use the procedures in the next
section.

• If you are connecting to a network using the TCP/IP or DECnet
protocols, choose 'Yes'.  The Setup Network dialog box appears.

Setup Network

5. Choose DECnet or TCP/IP.  For forms on which you can record the network
information that you need in order to configure your terminal for TCP/IP or
DECnet connections,  see Appendix B, "How to Connect to a Network."

6. Enter the required network information in the appropriate network setup
dialog box.

7. Choose OK.

The Setup Network dialog box reappears.
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If you need to connect to both the DECnet and TCP/IP networks, from the
Setup Network dialog box, select the button for the other network that you
wish to connect to and enter the required network information.

8. Choose OK.

The Setup Network dialog box reappears.

9. Choose Done.

A prompt screen appears for selecting whether or not you wish to restart
your system with your network settings configured.

10. Choose 'Yes' to restart or 'No' to cancel the configuration of network
settings.

How to Start Your First Session
The following display shows the screen that appears when you move your cursor
on top of the VT LAN40 icon, which is the leftmost icon in the Control Center.
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1. Click on the VT LAN40 icon in the Control Center.

The New Session dialog box appears.

2. Enter a session name.

Tips for Creating a Session Window

You might want to use a name that describes the function of the session,
such as mail or accounts. The name can be no longer than eight
alphanumeric characters.

3. Choose OK.

The Session Setup dialog box appears.
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4. Select the Communications Port type.

5. Choose the Configure button under the Port type option in the dialog box.

• If you select Serial or Serial Multisession, be certain that the Port, Baud
Rate, and other settings match your configuration.

• If you select LAT, enter a service name for your LAT connection and
the name of the node to which you want to connect.

• If you select Telnet, enter the Telnet setup information.

• If you select CTERM, enter a Host name.

6. After you enter the appropriate information and select settings, choose OK.
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How to Communicate with a Host
Computer
If you select the Serial Multisession port, you can create several simultaneous
session windows on a single communications port. For every session that you
open, an individual session window appears.

1. Position the cursor in the session window,

2. Click.

3. Press the Enter key.

Note

If you do not see your login prompt in the session window, toggle the
Hold Screen button on the VT LAN40 Toolbar to green.

For descriptions of the Toolbar icons, see the end of this Quick Start.

4. Enter the usual information that you need to log in to your host computer.

For example, you can enable multiple sessions when you log in to your host
computer as follows:

a. At the Local> prompt, enter the following command:

Local> set port multi enable

b. Press the Return key.

c. Continue with your login procedure.

You can also permanently set a terminal server port to enable multiple
sessions as follows:
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a. At the Local> prompt, enter the following command:

Local> define port multi enable

b. Press the Return key.

5. Choose Save from the Session menu.  Because you saved your session, you
can start another session with the same feature settings.

How to Start Your Next Session
To start another session with the same settings as the first session

1. Choose Open from the Session menu.

2. Enter the appropriate information as the dialog boxes appear.

3. Choose OK to confirm your choices.

To start a new session with different settings

1. Choose New Session from the Session menu, or click on the VT LAN40
icon.

2. Enter the appropriate information as the dialog boxes appear.

3. Choose OK to confirm your choices.

How to Exit and Save a Session
The following procedure allows you to save your session settings so that the
terminal can use those settings when you create a new session.

1. Log out of your existing session.

2. Choose Exit Session from the Session menu.

3. If you made any changes to your configuration or wish to save any layouts,
select from the prompts for saving configurations and layouts.

4. Choose OK to exit a session.

If you want to exit all open sessions at once, select Exit All from the Session
menu and select from the prompts for saving configurations and layouts.
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The VT LAN40 Toolbar
At the top of the VT LAN40 window, just below the Menu bar is the VT LAN40
Toolbar.

To use a button, click on the icon. A dialog box is displayed for the function.

For detailed information about each of the Toolbar functions, see the Operating
Information section of this guide.

Following are descriptions of the functions for the Toolbar buttons.

    Open Session    Starts the a session in a new window.

    Print    Prints some or all of page memory. The amount printed depends
on the selection that you choose for print options.

    Copy    Copies the selected area of the emulation window.

    Paste    Sends the selected area of the emulation window to the host. You
also can send a copy of the contents to the host if you do not select an area of the
emulation window.

    Colors    Displays the Attribute Colors dialog box from which you can
map colors to the various character attributes.

    Reduce Font    Decreases the font size of the text in the emulation window
by one increment.

    Enlarge Font    Increases the font size of the text in the emulation window
by one increment.

    Show Keyboard    Displays the on-screen VT keyboard.

    Next Session    Switches to the next VT LAN40 application window from
the list at the bottom.

    Hold Screen    Stops and restarts output to the emulation window.
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About This Guide

This guide provides a quick-start procedure and detailed operating procedures
for the VT LAN40 terminal.

Audience
This guide is for users and system administrators who want to configure and
operate their VT LAN40 terminal.

For More Information
For more information, refer to the VT LAN40 Installation card, which contains
detailed information about installing your LAN terminal.

See the inside back cover of this guide for ordering information.

Environment
This product has been designed and manufactured to minimize the impact to the
environment.  The packaging is recyclable, and the terminal can be returned for
proper disposal.  The terminal also has power management features that exceed
the Environmental Protection Agency Energy Star requirements for saving
energy.
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1
How to Use Your

VT LAN40 Features

This chapter explains all VT LAN40 icons and how to use the VT LAN40
features. Your VT LAN40 terminal uses a  graphical Windows environment.
When you use the elements of the system design correctly, you ensure that your
computer's memory is shared efficiently among applications while you work
with sessions.

Each application that you start appears as a separate window. Your work takes
place on the desktop, which is the screen space that your system occupies. You
can move work items around on the desktop, bring new items onto it, and
remove those that you do not need.

The VT LAN40 Control Center
The Control Center illustrated in Figure 1-1 appears at the top of the display
immediately after you turn your system on.

Figure 1-1  VT LAN40 Control Center
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The icons in the Control Center allow you to:

• Open the VT LAN40 window.
• Set up the network and system configuration.
• Display a calculator, calendar, and the system clock.
• Manage desktop functions in the Control Panel.
• Activate the Window screen saver.

Table 1-1 describes each of the icons and its function. To use a Control Center
function, click on the desired icon.

Table 1-1  VT LAN40 Control Center Functions

Control
Center Icon Use and Action

Launches the VT LAN40 application.  Click to display the
window for opening and using VT LAN40 sessions.

Displays the Configuration Options dialog box, from which you
can set up the network configuration and all other configuration
options.

Displays a calculator that can perform both standard and scientific
calculations, depending on the type of calculator view that you
select.

Displays the monthly calendar. The calendar can display any
month from January 1970 to January 2038.

Displays the system clock. To change clock settings, click on the
clock face to display the clock menu. To close and save the clock
and clock settings, press Alt F4 while the clock displays.

Displays the Control Panel group of icons.  Functions that you can
use and control from the Control Panel are: colors, ports, mouse,
desktop, keyboard, printers, international settings, date and time,
and resolution settings.

Activates the VT LAN40 screen saver, which can be password
protected.
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The VT LAN40 Control Panel
The Control Panel allows you to customize terminal settings such as the mouse,
communication ports, keyboard, and window colors. To open the VT LAN40
Control Panel group, click on the Control Panel icon.

 Control Panel Icon

Table 1-2 describes each of the icons and its function. To use a Control Panel
function, double click on the desired icon.

Table 1-2  VT LAN40 Control Panel Functions

Control
Panel Icon

Use and Action

Displays the Define Custom Colors dialog box, from which you
can change the color of one or more of the screen elements in your
window.

Displays the Ports dialog box, from which you can specify the
baud rate for local printer access.

Displays the Mouse dialog box, from which you can change the
mouse characteristics.

Displays the Desktop dialog box, from which you can change the
screen background and customize the way that windows and icons
appear on your screen.

You can also change the screen saver characteristics and the
screen saver password.

Displays the Keyboard dialog box, from which you can change
your keyboard characteristics.
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Table 1-2  (Cont.) VT LAN40 Control Panel Functions

Control
Panel Icon

Use and Action

Displays the Printer dialog box, from which you can change the
options for your printer.

Displays the International dialog box, from which you can change
the options for the keyboard layout, measurement unit, and
international date and time format.

Displays the Date/Time dialog box, from which you can change
the system date and time.

Displays the Set Resolution dialog box from which you can
customize the VT LAN40 window display.

Displays the Energy Star setting configuration dialog box, from
which you can adjust the energy saving mode intervals.

Check System Resources
The System Resource Monitor automatically appears in the lower left corner of
the VT LAN40 display.

System Resource Monitor

The system monitor display window that appears if you double click never
indicates 100% for any of the resources it monitors.
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Following are typical initial values that exist for resources when your VT
LAN40 terminal starts up:

U95:G83:M85

If a monitor column displays yellow, do not start additional applications. If a
column displays red, exit from applications in order to restore adequate memory
resource levels.

How to Customize Your Terminal Startup
You can set up customized configurations for the startup display of the Control
Center and the programs displayed from the Applications command in the
System menu.

In order to view configuration options, use one of the following methods:

• Click on the Control Center configuration icon

  Configuration Icon

The Configuration Options dialog box appears, as illustrated in Figure 1-3.

• Click on the Control-menu box that appears in the upper left corner of the
Control Center.

  Control-menu Box

The System menu appears, as illustrated in Figure 1-2.
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Figure 1-2  System Menu

Select Configuration.

The Configuration Options dialog box appears, as illustrated in
Figure 1-3.
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Figure 1-3  Configuration Options Dialog Box

From this dialog box, you can manage all the configuration options. Use the
procedures in the next sections if you wish to customize the configuration
for your terminal.
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To Change the VT LAN40 Startup
From the Configurations Options dialog box, you can select which applications
are to start automatically when you turn your terminal on.

1. Select Auto Start from the Configuration Options dialog box.

The Program Auto Start Selection dialog box appears, as illustrated in
Figure 1-4.

Figure 1-4  Program Auto Start Selection Dialog Box

2. Click an application in the Available area to highlight that application to be
autostarted.

3. Choose Add to move the highlighted application to the Auto Start area.

Repeat Steps 2 and 3 until all the applications to be autostarted are in the
Auto Start area in the window.

4. Choose OK.

The Configuration Options dialog box reappears.
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To Change Programs Displayed on the Control Center
From the Configurations Options dialog box, you can customize the programs
that appear on the Control Center.

1. Select Display List from the Configuration Options dialog box. The
Programs To Be Displayed dialog box appears, as illustrated in Figure 1-5.

Figure 1-5  Programs To Be Displayed Dialog Box

2. Click on a programs in the Available Programs area to highlight that
program so that it displays when the VT LAN40 starts up.

3. Choose Add to move the highlighted program(s) to the Programs To
Display area.

Repeat Steps 2 and 3 until all the programs to be displayed on the Control
Center are in the Programs To Display area in the window.

4. Choose OK.

When you close the Configurations dialog box, the Control Center displays
showing your new program selections.

The Configuration Options dialog box reappears.
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6. Use one of the following procedures:

• To accept the configuration settings, choose Done.
• To activate system security, use the procedures in the next section.

To Set Up VT LAN40 Security
In addition to customizing the configuration settings, you can also set up
security so that you can change setting options only if you enter a password.

1. Click on the Password Protected checkbox in the Configuration Options
dialog box, and then choose Set Password.

The Set Password dialog box appears.

2. Type in a password. Before you choose OK, record that password and store
it in a secure place.

3. Choose OK to make the password active or Cancel to cancel the password
use.

The Configuration Options dialog box reappears.

4. Choose Done.

Tips About VT LAN40 Security

Once you set up a password, you can restore the factory settings or
change your configuration settings.

1. Click on the Control-menu box in the Control Center. The System
menu appears.

2. When you select an option such as Configuration or Restore Factory
Settings, you must enter your password in the Password dialog box that
appears before you can continue.

3. Choose OK and change the desired settings.

After you change settings and the Configuration Options dialog box
reappears.

4. Choose Done.
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VT LAN40 Overview:

Sessions and Layouts

Each time you turn on your VT LAN40 system, the Control Center displays at
the top of your window. In the bottom left corner of your window is the system
monitor icon that dynamically tracks and displays system memory use.

Figure 2-1 illustrates the VT LAN 40 Control Center, which displays as soon as
you turn your system on and contains icons that represent the applications that
you can start. The VT LAN40 icon is the leftmost icon in the Control Center.

Figure 2-1  VT LAN40 Control Center

To display the VT LAN40 application on your desktop, click on that icon.

  Open a session
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Parts of a VT LAN40 Window
The elements of a window allow you to work with the window as well as with
the application within that window. Most windows have certain elements in
common, such as a title bar and menus. Not all windows, however, have every
element. Figure 2-2 illustrates the VT LAN40 window, shown with the elements
labeled. This window appears when you click on the VT LAN40 icon in the
Control Center.

Figure 2-2  VT LAN40 Window
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Table 2-1 describes the window elements illustrated in Figure 2-2.

Table 2-1  VT LAN40 Window Elements

Window Area Description

Insertion point Shows where you are in a window by marking the place where
text and graphics appear when you begin typing or drawing. The
shape of the insertion point might vary among applications.

Control-menu
box

Located in the upper-left corner of each window. Click on the
Control-menu box to open the Control menu. You use this menu
to display or remove the menu bar, or to resize, move, and close
windows. The Control-menu box on the Control Center allows
you to access the System menu, from which you can choose such
functions as configuration options, hard reset and terminal
shutdown, lock screen, and Restore factory settings.

Title bar Shows the session name or [None] if a new session has just been
opened. If more than one window is open  and when multiple
sessions are open to your host, the title bar for the active window
has a color or intensity different from other title bars.

Toolbar Provides icons that represent commands that are available from
your desktop window. You can click on a button to complete
commands or actions more quickly and without using a menu. For
more information, see "Using the ToolBar" in this chapter.

Menu bar Lists the available VT LAN40 menus. A menu contains a list of
commands, or actions, that you can carry out.

Maximize
button/
Minimize button

Click the Maximize button to enlarge the active application
window so that it fills the entire desktop. Click the Minimize
button to reduce the window to an icon. You can also use the
Maximize and Minimize commands on the Control menu.

Restore button Contains both an up arrow and a down arrow. This button replaces
the Maximize button after you enlarge a window, and therefore is
not shown in Figure 2-2. You can click the Restore button to
return the window to its previous size. If you are using the
keyboard rather than a mouse, you can use the Restore command
on the Control menu.
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Table 2-1 (Cont.) VT LAN40 Window Elements

Window Area Description

Mouse pointer When you move the mouse, the position of the pointer changes on
the screen. The shape of the mouse pointer might vary among
applications and even among documents within the same
application.

Horizontal/
Vertical scroll
bars

Allow you to move to a part of a session that has scrolled off the
screen. Click the scroll arrows with the mouse to move through
the display one line at a time.

Window border The outside edge of a window. You can change the window size
by lengthening or shortening the border on each side of a window.

Using the Toolbar
At the top of the VT LAN40 window, just below the Menu bar is the Toolbar, as
illustrated in Figure 2-3.

Figure 2-3  VT LAN40 Toolbar

Each of the icons on the Toolbar allows you to choose a command. To choose a
command, click on the icon. A dialog box is displayed for the function.
Following are descriptions of the functions for the Toolbar.

    Open Session    Starts the named session in a new window.

    Print    Prints some or all of page memory. The amount printed depends
on the selection that you choose for print options.

    Copy    Copies the selected area of the emulation window.

    Paste    Sends the selected area of the emulation window to the host. You
also can send a copy of the contents to the host if you do not select an area of the
emulation window.
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    Colors    Displays the Attribute Colors dialog box where you can map
colors to the various character attributes.

    Reduce Font    Decreases the font size of the text in the emulation window
by one increment.

    Enlarge Font    Increases the font size of the text in the emulation window
by one increment.

    Show Keyboard    Displays the on-screen VT keyboard.

    Next Session    Switches to the next session window from the list at the
bottom of the Session menu.

    Hold Screen    Stops and restarts output to the emulation window.

Multiple Sessions
A session is an active connection between the VT LAN40 and a host system.
You can run the VT LAN40 in multiple application windows, each window
containing a session with the same or a different host.

To have multiple sessions connected through the same port, your network
hardware and software must support multiple sessions.

By saving a layout for multiple sessions, you can quickly restore, change, or
copy information about individual sessions.   Layouts are explained later in this
chapter.
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Session Menu Commands
Figure 2-4 illustrates the Session menu, which contains commands for working
with sessions (and a printer, if you install a local printer).

Figure 2-4  Session Menu

Menu Options

The following options are available from the Session menu.

New Session...    Creates and names a new session in another window.

Open Session...    Starts the named session in a new window.

Restore Saved Settings    Restores the previously saved settings.

Save    Saves the current session using the current configuration name.

Save As...    Displays the Save As dialog box. The options in this dialog box
allow you to  specify a session name for the configuration that you are saving.

You also can select which components of the configuration to save.

Print...    Prints some or all of page memory. The amount printed depends on the
selection you make under Extent in the Print dialog box.
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Close Print Job    Forces immediate printing of accumulated printer data. You
can use Close Print Job only when there is data waiting to print.

Print Setup...    Displays the Print Setup dialog box where you can select the
printer to use. Other options depend on the printer you select. For details about
setup for a printer, see Chapter 5, "How to Set Up and Use A Local Printer".

Exit Session    Exits the current VT LAN40 window.

Exit All...    Exits all VT LAN40 sessions.

New Session...
1. Choose the New Session command on the Session menu.

The New Session dialog box appears, as illustrated in Figure 2-5.

Figure 2-5  New Session Dialog Box
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2. Type the name for the new session.

Tips for Naming a Session

You might want to use a name that describes the function of the session,
such as mail or accounts.  The name can be no longer than eight
alphanumeric characters.

3. Choose OK.

When you open your first session on the terminal, the Session Setup dialog
box appears, as illustrated in Figure 2-6. The options for session setup allow
you to provide the correct communications port setup information for your
first session.

Thereafter, when you open a new session, a dialog box for session setup
appears only if no setup exists. To change the setup, use the
Communications command (Options menu).

Figure 2-6 illustrates the Session Setup dialog box for a new session.

Figure 2-6  Session Setup Dialog Box
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4. From this dialog box, you can select the following options:

• A communications port type.

• Configuration options for the port type that you select (use the
Configure button that appears in Figure 2-6 under the Communications
Port area).

• The terminal mode for you terminal.

• Configuration options for the terminal mode that you select (use the
Configure button that appears in Figure 2-6 under the Terminal Mode
area).

For details about the port type and terminal mode, see Appendix B, "How to
Make a Connection."

Open Session...
Choose the Open Session command on the Session menu.

The Open Session dialog box appears, as illustrated in Figure 2-7.

Figure 2-7  Open Session Dialog Box

To start a previously created session

1. Display the Open Session dialog box, using either of the following methods:

• Choose the Open Session command on the Session menu.

• Use the Open Session button on the VT LAN40 Toolbar.
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     Open Session button

2. Select a session from the Existing Sessions list, or type a session name in
the Name box.

3. Choose OK.

The session starts in a new window.

To switch to another open session

If you have more than one session open, you can switch among them using any
of the following methods:

• Click anywhere in the window of the session that you want to be active.

• Select an item from the list at the bottom of the Window menu.

• Double click on the desktop to activate the Task List window, highlight the
session that you wish to switch to, and press the Switch To button.

• Click on the Next VT LAN40 button on the VT LAN Toolbar to switch to
the next session shown in the list at the bottom of the Window menu.

     Next VT LAN40 button

• Press Alt Tab, Alt Esc or the F4 key.

To connect a session

If the Auto Connect command is selected on the Connection menu, your
terminal is connected to the configured communications port when VT LAN40
starts, or whenever you change the port type or network address. Otherwise, you
must connect a session manually.

Use any of the following methods to connect a session:

• Choose Connect from the Connection menu.

• Choose the Connect button on the status bar.
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To disconnect a serial or network session

Choose Disconnect from the Connection menu.

The Session window remains on the screen.

Save
The Save command on the Session menu saves the current configuration and
current user mappings. The VT LAN40 uses the current session name.

If you want to save your configuration under a different name, use the Save As...
command from the Session menu.

Save As...
The Save As... command on the Session menu displays the Save As dialog box,
as illustrated in Figure 2-8.

Figure 2-8  Save As Dialog Box

The options in this dialog box allow you to specify a name. If you want to save
the complete configuration under the current name, you can use the Save
command from the Session menu.

Dialog Box Options

Name    Type a configuration file name or select a session name from the list
under Existing Sessions.

Existing Sessions    A list of previously created sessions.
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Print...
The Print command on the Session menu is explained in Chapter 5, "How to Set
Up and Use a Local Printer."

Close Print Job
The Close Print Job command on the Session menu flushes accumulated printer
data from the VT LAN40 buffers. It affects all modes of printing: the Print
command, print key, escape sequences, and autoprint. The action taken depends
on the type of printer configured. At the end of a flush, a form feed is sent to the
printer, causing it to eject the last page.

Print Setup...
The Print Setup command on the Session menu is explained in Chapter 5, "How
to Set Up and Use a Local Printer."

Exit Session
The Exit Session command on the Session menu displays the Exit dialog box
which allows you to exit the current VT LAN40 window. If you made changes
to your configuration, the VT LAN40 might prompt you to save the
configuration.

If you want to exit one of several open sessions, use this command; otherwise
use the Exit All command. The display of prompts that allow you to save
configuration and layout options depends on whether or not you have checked
the options for saving changes on exit in the General Settings dialog box
(Options menu).

Exit All...
The Exit All command on the Session menu exits all VT LAN40 sessions, as
illustrated in Figure 2-9.
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Figure 2-9  Exit Dialog Box

If you made changes to your configuration or layout, the VT LAN40 might
prompt you to save those changes, depending on whether you change the
configuration in the Exit Settings dialog box (Options menu).

This Exit dialog box also provides you a prompt message to verify that you want
to exit all of the sessions that are currently connected.

Window Menu and Layout Commands
This part of the chapter provides information about how to use the Window
Menu, open layouts, and save layouts. A layout provides information about a
group of session windows, their positions on the desktop, and their host
connections.

Figure 2-10 illustrates the Window menu which contains commands that control
multiple sessions.

Figure 2-10  Window Menu
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Menu Options

Next Session    Switches to the next VT LAN40 application window from the list
at the bottom.

Open Layout...    Starts all VT LAN40 application windows in the specified
layout, and connect to individual hosts.

Save Layout...    Saves information about all VT LAN40 application windows in
a layout.

(List of Sessions)    Shows all the current VT LAN40 session windows. The
window that you select becomes active.

Next Session
The Next Session command on the Window menu switches to the next
VT LAN40 application window from the list at the bottom of the Window
menu.

Open Layout...
The Open Layout command displays the Open Layout dialog box, as illustrated
in Figure 2-11. This command starts all VT LAN40 application windows and
connects to individual hosts.

Figure 2-11  Open Layout Dialog Box
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If a VT LAN40 window described in the selected layout is already running (as
identified by its host connection), that window is not restarted, it is only moved
on the desktop to the position designated for it in the previously saved layout.
Any existing VT LAN40 windows that are not part of the selected layout are not
changed.

Dialog Box Options

Existing Layouts    Click on a name from the list.

Save Layout...
The Save Layout command displays the Save Layout dialog box, as illustrated
Figure 2-12.

By saving a layout for multiple sessions, you can later restart all the sessions on
your desktop in the same position they occupied when you made the layout.

Figure 2-12  Save Layout Dialog Box

The options in this dialog box allow you to specify a name for the layout.  You
can also select and delete an existing layout.

Dialog Box Options

Name   Type a layout name.

Existing Layouts    Click on a name from the list.
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To save a layout of one or more sessions

1. Choose the Save Layout command on the Window menu.

2. Type a layout name or select an existing layout name.

Tips for Naming a Layout

You might want to use a name that describes the function of the layout,
such as mail or accounts.  The name can be no longer than eight
alphanumeric characters.

3. Choose Save to save the layout or Cancel to cancel the operation.

To start a previously saved layout

Use any of the following methods:

• Choose the icon on the Control Center for opening a session that you
previously used when you saved the layout.

• Use the Windows menu:

1. Choose the Open Layout command on the Windows menu.

2. Click on the name of the layout that you wish to open.

3. Choose OK.

Either method simultaneously restarts several sessions, in their former positions
on your desktop.

If a session described in the layout is already open (as identified by its host
connection) that session is not restarted, it is only moved on the desktop to its
position in the previously saved layout. Any existing sessions that are not part of
the layout are not changed.
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To delete a layout

1. Highlight the layout to be deleted

2. Click on the Delete button.

List of Sessions
The list of sessions at the bottom of the Window menu shows all the currently
running VT LAN40 sessions.

The names displayed in the list on the Window menu are the names that appear
in the title bar of each VT LAN40 window.

To switch to any of these windows, click on its name on this list.
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3
How to Set Your

Terminal Options

Chapter 3 provides information about setting terminal configuration options for
communications (such as port assignment and baud rate), terminal displays,
keyboard use, graphics, local editing, and printing use.

Options Overview
After you install the VT LAN40, you must correctly configure communications
options for how your environment connects to the host system. You can also
customize other terminal configuration options such as user-preferred character
set, terminal type, keyboard layout, and display colors. You can change a
configured option whenever you want by choosing a command from the Options
or other menus, and changing the desired dialog box option.

If you choose the Terminal command from the Options menu, a cascaded menu
appears from which you can select options that change settings for:

• Your terminal type.

• The display, keyboard, graphics, local edit, and printer features that you
use.

Use one of the following methods to save your options settings:

• Set an option in the Exit Settings dialog box to save your configuration
settings when you exit the VT LAN40.

• Use the Save or Save As command from the Session menu.
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Options Menu Commands
Figure 3-1 illustrates the Options menu that controls many aspects of the
VT LAN40 terminal use.

Figure 3-1  Options Menu

Menu Options

View...    Displays the View dialog box so that you can change the character size,
and show or hide the various scroll and status bars.

Colors...    Displays the Attribute Colors dialog box so that you can map colors
to the various character attributes.
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Terminal...    Displays a cascading menu that allows you to change the way that
the VT LAN40 emulates a VT terminal.

Commands listed in the Terminal cascaded menu are:

General...    Displays the Terminal General dialog box, which allows you to
specify the settings for the type of terminal you want VT LAN40 to
emulate.

Display...    Displays the Display dialog box, which allows you to control the
appearance of the emulation window. You can set the number of columns
and lines, access the Colors and Attribute dialog boxes, and more.

Keyboard...    Displays the Keyboard dialog box, which allows you to select
settings for your keyboard. You also can define your own function keys, and
map actions to keys.

Graphics...    Displays the Graphics dialog box, which allows you to
configure how the terminal handles Sixel and ReGIS graphics.

Local Edit...    Configures the VT local editing functions.

Printer...    Configures various options controlling VT printing functions.

Communications...    Displays the Communications dialog box. The options in
this dialog box allow you to choose the port to use for communicating with the
host system. You also can select setup options, such as baud rate and network
characteristics from an associated setup dialog box.

History...    Displays the History dialog box, where you can specify a maximum
size for the History buffer in which to store information about a previously
displayed screen.

Exit Settings...    Displays the Exit Settings dialog box, containing other
configuration options.

SmartPad...    Displays the SmartPad dialog box. The options in this box allow
you to define your own buttons and button pads.

Keyboard...    Displays the Keyboard Mapping dialog box where you can assign
strings and VT functions to individual keys.

Menus...    Displays the Menus dialog box. The options in this box allow you to
define your own commands on the VT LAN40 menus or on the Menu bar.

Mouse...    Changes default mouse functions.
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Show Toolbar    Displays the Toolbar at the top of the application window.

Show SmartPad    Displays your custom button pad on the VT LAN40 status bar.

Show Keyboard    Displays the on-screen VT keyboard.

View ...
The View command on the Options menu displays the View dialog box, as
illustrated in Figure 3-2.

Figure 3-2  View Dialog Box

The options in this dialog box allow you to change the size of text in the
emulation window and to show or hide the various scroll and status bars.

Dialog Box Options

Font Width    Displays a drop-down list box from which you can select a font size
from 3 pixels wide to 24 pixels wide, or Auto. The Auto selection uses a font
size based on the window size.

If the window contains graphics, the View command makes the displayed image
larger or smaller. This appears to zoom the image.

The display size of different fonts on your screen depends on the resolution of
your display.
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You can repeatedly click on either of the following buttons on the VT LAN40
Toolbar to automatically increment a change of font size in your session
window.

To reduce or enlarge the session window font size

• Click on the Reduce Font button to decrease the font size of the text in the
emulation window by one decrement.

    Reduce Font
   

Continue to click on this button until the font size is satisfactory.

• Click on the Enlarge Font button to increase the font size of the text in the
emulation window by one increment.

    Enlarge Font

Continue to click on this button until the font size is satisfactory.

On a standard VGA (640x480) display, font sizes 5 Wide and 7 Wide show all
80 (or 132) columns in the full screen, even with the vertical scroll bar enabled.
Font size 8 Wide shows all columns only when you disable the vertical scroll bar.

On an 800x600 display, font sizes 5 Wide, 7 Wide, and 8 Wide show all 80 (or
132) columns in the full screen, even with the vertical scroll bar enabled. Font
size 10 Wide shows all columns only when you disable the vertical scroll bar.

The VT LAN40 automatically selects the font size for a 132-column display
based on the selected 80-column font size.

Vertical Scroll Bar    Displays a box in the scroll bar to indicate your position on
the page. If you activate the History feature, a box in the scroll bar indicates the
relative position in text that is no longer displayed in the emulation window.

Click on this checkbox so that you can use the vertical scroll bar to scroll up and
down the screen.

Horizontal Scroll Bar    Displays a box in the scroll bar to indicate your position
on the page. Use this bar to scroll left and right on the screen. The VT LAN40
dims the scroll bar if there is no additional data to view.
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Click on this checkbox so that you can use the horizontal scroll bar to scroll left
and right.

Status Bar    Displays the VT LAN40 Status Bar at the bottom of the session
window.

VT Status Line    Displays or hides the VT status line and allows you to specify
whether the Status line is positioned above or below the horizontal scroll bar.

Language    This feature is unavailable in the U.S. version of the VT LAN40.
In VT LAN40 International versions, you can select any of the following
languages for the display of all menus, commands, dialog boxes, and system
messages: English, French (Français), German (Deutsch), or Spanish (Español
Latino).

Colors...
The VT LAN40 emulates the color features of the VT340 terminal. VT LAN40
allows you to add more colors to your display by mapping character attributes
(bold, inverse, underline, and blink) to colors.

VT LAN40 supports the ISO Color sequences, which allows the host to control
the foreground and background colors independently of the other visual
attributes.

VT LAN40 provides default colors for each attribute, attribute combination, and
the ISO colors. You can change these default colors to customize your screen
display.

The VT340 can display 16 colors at a time selected from a palette of 4096
colors. The VT LAN40 provides options that allow you to display the best color
match.
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To Display Color Options

Use any of the following methods to change Color options.

• Choose Colors on the Options menu, and then choose the Colors button.

• Choose Display from the Options Terminal menu, and then choose the
Colors button.

The Colors dialog box allows you to change VT LAN40’s colors.

• Click the Color button on the VT LAN40 Toolbar to display .

    Colors

The Attribute Colors dialog box that appears allows you to map colors to
the various character attributes.

Color Options

VT Color Index    Select the color you want to change. A number and name
identify the color.

Red, Green, Blue    Assign values (0 to 255) to the color ratios for the selected
VT Color Index.

To make gradual changes to colors, you must have Use Exact Colors selected.

Use Exact Colors    This option is available only if you select a resolution of 256
colors for your display (that is, a display with a palette).

To set your resolution display for 256 colors:

1. Click the Control Panel icon in the Control Center.

 Control Panel Icon

2. Double click on the Set Resolution icon.

Set Resolution
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3. The Set Resolution dialog box appears.

Select 800 X 600 for the Resolution, Normal for the Font, and 256 for the
number of colors.

4. Choose OK.

Lock User Colors    Select the checkbox to prevent the host from changing
colors. Normally the host can change any of the 16 colors defined by the
terminal. However, some host applications fail to restore the colors, altering the
appearance of VT LAN40’s text and graphics from other applications.

Reset    Restore colors to saved values.

Terminal
As illustrated in Figure 3-3, the Options Terminal commands display another
menu of commands that provide dialog boxes for changing the options in your
terminal configuration.

Use the following procedures to display the Options Terminal menu.

1. Choose Options from the VT LAN40 Menu bar.

2. Choose Terminal to display a cascaded menu.

Figure 3-3  Options Terminal Menu
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Table 3-1 displays the terminal functions that you can modify.

Table 3-1  Options Terminal Menu Commands

Command Type of Setting

General Terminal type

Display Emulation window appearance

Keyboard Function keys/keyboard mapping

Table 3-1  (Cont.) Options Terminal Menu Commands

Command Type of Setting

Graphics Sixel and ReGIS graphics handling

Local Edit Local edit functions

Printer Printer functions

Options Terminal: General...
The VT LAN40 emulates the VT420, VT320, VT220, VT100, and VT52 text
terminals. The VT LAN40 also emulates the VT340 and VT240 graphics
terminals. From the Options Terminal menu, the General command displays the
Terminal General dialog box, as illustrated in Figure 3-4.

Figure 3-4  Terminal General Dialog Box
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The options in this box allow you to specify the settings for the type of
terminal you want the VT LAN40 to emulate. Many of the options correspond
to the options available on the VT340 series terminals. Other options are
specific to the VT LAN40.

Dialog Box Options

Mode    Select the terminal operating mode from the following choices in the
drop-down list:

VT340/420 7bit   VT420 features with graphics and 7-bit control codes

VT340/420 8bit   VT420 features with graphics and 8-bit control codes

VT100   VT100-compatible

VT52   VT52-compatible.

ANSI-BBS   Suitable for many BBS hosts; compatible with the PC ANSI
mode.

401X   Emulates a Tektronix 401X series terminal similar to the way a
VT340 does.

DA Response    Select the Device Attributes response. The VT LAN40 sends
this response on a request from the host system. Select from the following
choices in the drop-down list:

VT LAN40  Provides a superset of the VT340 DA Response, including some
VT420 functions.

Custom  Responds with the strings stored in Custom Primary DA and
Custom Secondary DA.

Other values exactly match the DA response for that terminal type.

Custom Primary DA    Specify your own Primary Device Attributes response. If
you select Custom in DA Response, the VT LAN40 sends this string in response
to a Primary Device Attributes request. You can specify control codes that are in
the range 0 to 31 if you type a circumflex ^ followed by an upper-case alphabetic
character (for example, ^E ). You can also specify any special code if you type
a circumflex followed by three decimal numbers.
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Custom Secondary DA    Specify your own Secondary Device Attributes
response. If you select Custom in DA Response, the VT LAN40 sends this
string in response to a Secondary Device Attributes request. You enter
Control (Ctrl) and special codes as described in Custom Primary DA.

Caution

Be certain that you define a Custom DA response carefully because an
improperly formed DA response can cause erratic behavior in the
remote host.

Answerback    Specify your answerback string. You can enter up to 31
characters.

You enter control and special codes as described in Custom Primary DA. The
VT LAN40 sends this string in response to a ^E from the host.

Character Set Mode    Select the character set mode for the VT LAN40 to use
from the following choices in the drop-down list:

Multinational   Map the regular ASCII character set into the lower (7-bit)
character set, called GL. Also, you can map the supplemental User
Preferred Character Set into the upper (8-bit) character set, called GR. To
send and receive codes in the GR set, you need 8 bits of data. If you use a
serial port, ensure that your port can send all 8 bits.

National   Map one of the National Replacement Character Sets (NRC) into
GL. The National Character Set selection you choose determines the actual
NRC set used. National mode uses only 7 bits; therefore, GR is unavailable.

User Preferred Character Set    Select the 8-bit supplemental character set for VT
LAN40 to use from the following choices in the drop-down list:

DEC-MCS DEC Supplemental
ISO Latin-1 ISO Latin-1
ISO Latin-2 ISO Latin-2
IBM-PC IBM Graphics set

Quick Start/Operating Information  3-11



How to Set Your
Terminal Options ...

National Character Set Select a National Replacement Character Set from the
drop-down list. VT LAN40 uses this character set when you select National
under Character Set Mode. This selection does not affect the key labels of the
on-screen VT keyboard.

In VT LAN40 international versions, you can select the any of the following
National Replacement Character sets from the following choices in the drop-
down list:

N. American British Flemish Fr.Canadian
Danish Finnish German Dutch
Italian Swiss French Swiss German Swedish
Norwegian French/Belgian Spanish Portuguese

Local Echo    Select the checkbox so that the VT LAN40 displays the characters
it sends to the host. If the box is not checked, the host must handle echoes.

Lock User Keys    Select the checkbox so that the host system cannot change
user-defined key (UDK) definitions.

Lock User Features    Select the checkbox so that the host system cannot change
the settings of the user preference features, columns, scroll, and inverse screen.

Options Terminal: Display
From the Options Terminal menu, the Display command shows the Display
dialog box, as illustrated in Figure 3-5.
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Figure 3-5  Display Dialog Box

The options in this dialog box allow you to control the appearance of your
emulation window. Many of these options correspond to the options available
on the terminal; others are specific to VT LAN40.

Dialog Box Options

Columns    Select the page width for text. When you change the setting, the
VT LAN40 clears the screen. Select one of the following choices:

80 80 columns wide
132 132 columns wide

Lines    Select the number of lines per page for the session. This also determines
the number of pages. You can type in any number of lines between 24 and 144.
You can also select from numbers in the drop-down box that are compatible
with VT terminals:

24 (6 pages) 48 (3 pages)
25 (5 pages) 72 (2 pages)
36 (4 pages) 144 (1 page)
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Scroll    Select how many lines scroll onto the screen at one time from one of the
following choices:

Jump 1 One line
Jump 2 One-eighth of the window
Jump 4 One-quarter of the window
Disabled Does not scroll

Status Display    Specify how to use the VT status line from one of the following
choices:

None Do not display status line.
Indicator VT LAN40 uses it to write its status.
Host The host displays information on it.

Cursor    Specify the appearance of the cursor from one or more of the following
choices:

Show Display the cursor.
Block Display cursor as a block, not underline.
Blink Make the cursor blink.

Coupling    Specify whether to and how to scroll to keep the cursor visible from
one or more of the following choices:

Horizontal   Scroll horizontally when the cursor moves beyond the right or
left edge of a window.
Vertical   Scroll vertically when the cursor moves beyond the top or bottom
of a window.
Page   Automatically display a different page when the cursor moves to that
page in page memory.

New Line    Select the checkbox so that the RETURN key sends a CR and LF,
instead of just a CR.

Auto Wrap    Select the checkbox so that text automatically wraps to the next line
when it reaches the right margin.

Transparent    Select the checkbox so that the VT LAN40 displays received
control characters, rather than processing them.
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Inverse Screen    Select the checkbox to reverse the foreground and background
colors for normal text.

Tabs    Click the Tabs button to display the Tabs dialog box where you can set
and clear tabs.

Colors    Click the Colors button to display the Colors dialog box where you can
adjust VT LAN40’s colors.

Attributes    Click the Attributes button to display the Attribute Colors dialog box
where you can select the colors to use for the various character attributes (bold,
underline, inverse, blink), and their combinations.

Options Terminal: Keyboard...
The VT LAN40  keyboard layout closely resembles a VT keyboard. Most keys
are located where you expect to find them so that you can easily use VT
features. From the Options Terminal menu, the Keyboard command displays the
Keyboard dialog box, as illustrated in Figure 3-6.

Figure 3-6  Keyboard Dialog Box
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The options in this box allow you to select settings for your keyboard. You also
can define your own functions for the Shift+F6 through Shift+F20 function key
combinations. Options correspond to the VT420 terminal options or are specific
to the VT LAN40.

Dialog Box Options

Layout    Select your keyboard type from the following choices in the drop-down
list:

Enhanced
LK411/LK412

Editpad Arrangement    Select an arrangement for the six editing keys.

Keypad Mode    Select what the keypad keys send when pressed from one of the
following choices:

Numeric   The default setting that sends the ASCII code of the numbers
shown on the keycaps.
Application   Sends control sequences.

Cursor Key Mode    Select what the cursor (ARROW) keys send when pressed from
one of the following choices:

Normal   The default setting that sends ANSI cursor control sequences.
Application   Sends control functions.

Backspace Key    Select what the Backspace key sends when pressed from one
of the following choices:

Delete   The default setting that sends the Del character.
Backspace   Sends the BS character.

F1 Key    Select the action the F1 key performs when pressed from one of the
following choices:

Hold   The default setting that stops the scrolling of text.
FKey   Sends the VT F1 function key sequence.
Ignore   Do nothing.
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F2 Key    Select the action the F2 key performs when pressed from one of the
following choices:

Print   The default setting that performs VT print functions.
FKey   Sends the VT F2 function key sequence.
Ignore   Does nothing.

F3 Key    Select the action the F3 key performs when pressed from one of the
following choices:

Setup   The default setting that acts as an ALT key producing an  effect
similar to the VT setup function.
FKey   Sends the VT F3 function key sequence.
Ignore   Does nothing.

F4 Key    Select the action the F4 key performs when pressed from one of the
following choices:

Esc   The default setting for the action 'Next Session'.
FKey   Sends the VT F4 function key sequence.
Ignore   Does nothing.

F5 Key    Select the action the F5 key performs when pressed from one of the
following choices:

Break   The default setting for the action 'Send a break signal'.
FKey   Sends the VT F5 function key sequence.
Ignore   Does nothing.

Bell    Select when the bell sounds. You can select one or both values from one
or more of the following choices:

Margin   Sound when the text cursor approaches the right margin.
Warning   The default setting causing the bell to sound when operating
errors occur or the terminal receives ASCII BEL.

UDKs    Display the UDKs dialog box. Choose this button to assign character
strings to the Shift+F6 through Shift+F20 key combinations called user-defined
keys (UDKs). Normally, the host assigns values to the UDKs.

Mapping    Display the Keyboard Mapping dialog box. Choose this button to
display the pop-up VT keyboard from which can change the usual mapping of
PC keys to VT functions.
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Options Terminal: Graphics...
VT LAN40 emulates the ReGIS, Sixel, and Tektronix graphics features of the
VT340. You can view a dialog box that controls the appearance of graphics and
then control whether graphics are stored in a Display list or as a bitmap.

To print an image, at least one of these options must be selected. If you select
neither, you cannot redisplay the screen. If you select both, the VT LAN40 uses
the Display List when necessary (for example, after a zoom), and the Bitmap at
other times.

Using either or both of these methods increases the memory requirement of the
VT LAN40 session.

Use the Backing Store option in the Graphics dialog box to determine how the
VT LAN40 stores the graphics image in order to redraw it on the screen. Choose
from the following methods.

Display List (Default)

If you select this option, the VT LAN40 stores all the graphics commands in a
list and then redisplays the window by executing the entire list.

This option offers you the most flexibility when you want to change the font
size (zoom) and when printing.

The Display List method might not be suitable for an application that changes
parts of the screen without ever clearing the screen (for example, a real-time
monitor that displays the current state of some process).

Bitmap

If you select this option, VT LAN40 saves a copy of the image in memory. This
option allows the VT LAN40 to quickly redisplay the image from the copy in
memory. When you change the font size, VT LAN40 clears the screen because
it cannot redisplay the image at the new size.

The Bitmap method allows the VT LAN40 to redraw the screen faster than with
the Display List method does, but does not allow you to redisplay the image if
you change the font size.
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Options Terminal: Local Edit...
The VT LAN40 supports the local editing features of the VT300 series
terminals. In local editing mode, VT LAN40 stores the text you type in page
memory so that you can edit and send a block of edited text to the host. The
options in this box allows you to set configuration options related to local
editing.

Options Terminal: Printer...
The Printer command on the Options Terminal menu displays the Printer dialog
box. The options in this box allow you to select the printing mode and printer
options. For details about printing modes and printer options, see Chapter 5,
"How to Set Up and Use a Local Printer."

History...
The History feature allows you to view, copy, and paste data that has scrolled
off your display (data that no longer appears in the session window). This
feature allows you to review lines of your session that were previously
displayed. You can also specify values for the display operations, such as a
maximum size for stored text.

The VT LAN40 stores text that scrolls off the screen or text that you clear from
the screen using the Clear command.

The history appears above the first VT page in your session window. When the
VT LAN40 displays the History, the vertical scroll bar box shows your position
within the viewed page and History.

To activate the History feature

Use either of the following methods:

• Choose Enable History from the Connection menu.

• Choose History from the Options menu and select Enable History in the
History dialog box.
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To view the history

Use any of the following methods to view the history:

• Move the vertical scroll bar on the right side of the screen.

• Press Ctrl+Up Arrow and Ctrl+Down Arrow to view the previous or next
line.

• Press Ctrl+Shift+Up Arrow and Ctrl+Shift+Down Arrow to view the
previous or next screen.

To remove all information from the history

While viewing the session containing the history data, choose the Clear History
command from the Connection menu.

Exit Settings...
After setting your configuration or layout items, you might want to save some or
all of this information. The Exit Settings command on the Options menu
displays the Exit Settings dialog box, as illustrated in Figure 3-7.

Figure 3-7  Exit Settings Dialog Box

If you have made changes in your VT LAN40 terminal configuration, this dialog
box controls whether changes are automatically saved when you exit.
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Dialog Box Options

Save Changes on Exit    Choose one of the following choices to indicates whether
configuration changes that you make are saved when you exit.

Yes   Changes are always saved.
No   Changes are not saved.
Prompt   If you have changed the configuration, you are asked if you want
to save the changes when you exit VT LAN40.

Save Layout on Exit    Select the checkbox if the layout changes that you make
are to be saved when you exit.

Prompt on Exit All   If you have changed the layout, select from one of the
following choices so that you are prompted to save changes when you exit the
VT LAN40 using the Exit All command.

Yes   A prompt screen displays before you can exit.
No   No prompt screen displays before you exit and changes are not saved.
If Connected   A prompt screen displays before you can exit, if you are
connected to a network.

SmartPad...
The SmartPad feature allows you to define an on-screen Toolbar. You can
display the Toolbar in a separate window or on the VT LAN40 status bar at the
bottom of a session window. The status bar can display only one line of the
Toolbar.

Keyboard...
The Keyboard command on the Options menu displays the Keyboard Mapping
dialog box, as illustrated in Figure 3-8.
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Figure 3-8  Keyboard Mapping Dialog Box

The options in this dialog box allow you to change your keyboard mapping.

To map a keyboard key

1. Press the key on the keyboard that you wish to define.

The key or key sequence that you press appears in the PC key area of the
window.
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Figure 3-9  Example of How to Map a Key

2. Choose the Keyboard button on the Keyboard Mapping dialog box.

The on-screen VT keyboard displays in front of the dialog box, as
illustrated in Figure 3-9.

3. Select a key on the on-screen VT keyboard.

In this example, the keypad key for the minus (-) is selected.

A dotted box appears on top of the key that you select. In this example, you
can see the dotted box on top of the - key (shown on the right side of the on-
screen keyboard in Figure 3-9).

4. Choose the Done button on the Keyboard Mapping dialog box to map the
key name to the keyboard key that you select. Choose Cancel to cancel the
mapping operation.

Menus...
The Menus command allows you to customize the Menu bar and menus. You
can add menu items, and define them for ALT key access. You could also
remove commands. Items can display a cascading menu or perform an action.
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Mouse...
The Mouse command allows you to change mouse functions and to assign
characters and VT functions to mouse buttons.

Show Toolbar
Choose this command from the Options menu to display the Toolbar at the top
of the application window.

Show SmartPad
Choose this command from the Options menu to display your custom button pad
on the VT LAN40 status bar.

Show Keyboard
The Show Keyboard command displays an image of the on-screen VT keyboard,
as illustrated in Figure 3-10.

You will find the on-screen VT keyboard useful to access keys you normally
cannot easily access on your keyboard because:

• Your keyboard does not have convenient access to the required functions.

• You have some keys mapped, preventing you from using the original key
functions.

The key labels of the on-screen keyboard can be changed to French or German
labels according to the National Character Set you select in the Terminal
General dialog box from the Options Terminal menu.
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To display the on-screen VT keyboard:

Use either of the following methods:

• Choose Show Keyboard from the Options menu to display the on-screen
VT keyboard, if not already displayed.

• Choose the VT Keyboard button on the VT LAN40 Toolbar.

     VT Keyboard button

The on-screen VT keyboard displays.

Figure 3-10  On-Screen VT Keyboard

To use the on-screen VT keyboard

• Click the keys that you want sent to the host.

The VT LAN40 sends these keys to the host just as if you pressed the actual
keys on your regular keyboard.

To remove the on-screen VT keyboard

Use any of the following methods while you are viewing the keyboard:

• Choose Show Keyboard again from the Options menu.

• Choose Close from the Control menu on the top left corner of the on-screen
keyboard.

• Click the VT Keyboard button on the Toolbar.
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How to Edit Information

from the Display

Chapter 4 provides information about the following editing functions: copy,
paste, select, and block select.

Edit Menu Commands
Figure 4-1 illustrates the Edit menu, which contains commands for selecting and
pasting areas of the emulation window.

Figure 4-1  Edit Menu
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Menu Options

Copy    Copies the selected area of the emulation window.

Copy Special...    Displays the Copy Special dialog box. The Copy Type option
in this box allows you to specify the data format that you want the VT LAN40
to use. The Copy option copies the selected area of the emulation window.

The Cancel option returns you to the emulation window without copying.

Paste    Sends the selected area of the emulation window to the host.

Select    Selects text using your keyboard. This command allows you to select
irregular areas of the emulation window.

Block Select    Selects text using your keyboard. This command allows you to
select rectangular areas of the emulation window.

Copy
The Copy command on the Edit menu creates a copy of the selected text and
graphics.

By default, the VT LAN40 adds a carriage return and linefeed to the end of each
line of text. The Copy Special command allows you to use a different line
terminator from the defaults.

To copy a selection

Before you can copy data from your VT LAN40 emulation window, you must
select the area that you want to copy.

Once you select the area to be copies, use any of the following methods:

• Click the Copy button on the VT LAN40 status bar or the Copy button on
the VT LAN40 Toolbar.

     Copy button

• Choose Copy or Copy Special from the Edit menu.

Copy Special...
The Copy Special command on the Edit menu copies a selected area, as
illustrated in Figure 4-2.
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Figure 4-2  Copy Special Dialog Box

You can use this command only after selecting the area you want to copy.

The Copy Special command allows you to specify whether to use the selected
area in a word processing document or a spreadsheet. Your choice determines
the type of line terminator VT LAN40 uses.

To copy a selection with a special format:

1. Choose Copy Special from the Edit menu.

2. Under Copy Type, select an option.
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Table 4-1 describes the copy type options.

Table 4-1  Copy Type Options

Select In order to copy the following...

Data Text without any formatting or line terminators. This is most useful
when the text is being pasted back to the host as command line data.

Lines Text with carriage return and linefeed added to the end of each line.
This is the same as selecting Copy from the Edit menu.

Paragraph Text for use in a word processing application. To prevent words from
running together, VT LAN40 inserts a space at the end of a line. VT
LAN40 inserts a carriage return and linefeed only before a blank line.

Table Text for use in a spreadsheet or word processing table. VT LAN40 changes
white space between words into a single tab character. Most spreadsheets
and word processor tables interpret tab characters as cell separators.

3. Choose the Copy button.

Paste
The Paste command on the Edit menu sends the selected text to the host. The
format of the data sent to the host depends on the type of mouse button that you
press:

• If you press the left mouse button (stream select) , the VT LAN40 sends the
selection with the “Data” mode of formatting—without line terminators.

• If you press the right mouse button (block select) , the VT LAN40 pastes
the selection with the “Lines” mode of formatting—with a terminator at the
end of each line.

Graphics cannot be Pasted. The VT LAN40 always translates data that you paste
to your host character set.

To paste a selection to the host

Use any of the following methods:

• Click on the Paste button on the VT LAN40 status bar or the Paste button on
the VT LAN40 Toolbar.

     Paste button
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• Choose Paste from the Edit Menu.

To paste text to the host

1. Be certain that there is nothing selected on your screen.

2. Choose Paste from the Edit menu.

Select
You can use the keyboard or the mouse to select text from the session window.
The Select command on the Edit menu allows you to select areas of the
emulation window using your keyboard.

To select text with your mouse

1. Place the cursor at the beginning of the text that you wish to select.

2. Press and hold the left mouse button.

3. Position the mouse in the upper left corner of the text that you wish to select.

4. Drag the mouse to the lower right corner of that block of text.

5. The area that you select is highlighted.

If the area contains graphics, VT LAN40 converts the selected area to a
rectangular block.

Host communications stop while you are selecting text. VT LAN40 displays the
selected area using the inverse video attribute. You also can select text from the
viewed history.

Block Select
You can use the keyboard or the mouse to select text from the session window.
The Block Select command on the Edit menu allows you to select a rectangular
area (block) of the emulation window using your keyboard.
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How to Set Up and
Use a Local Printer

VT LAN40 provides all the VT printing functions: Print Screen, Autoprint
mode, and Printer Controller mode.

The Print command (Session menu) and the VT Print key emulate the VT print
functions.  These commands print all or part of the emulation screen, and allow
you to print data that you have already received.

Set Up for a Printer
To set up a printer

1. Install your printer using the Windows Control Panel if you have not done
so.

2. Choose Print Setup from the VT LAN40 Session menu.

The Print Setup command on the Session menu displays the Print Setup
dialog box.

3. Select a printer from the list of installed printers.

4. Click on the Options button to configure the printer with Windows setup.

The remaining options depend on the printer you select and might include
whether to print in portrait or landscape orientation, the paper size and
source, and advanced features such as dithering.
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To set up your printer options

Choose Printer from the Options Terminal menu to specify options for your
local printer, such as font, termination character, and printer mode.

Procedures for Printing
The VT LAN40 allows you to print by pressing a key or by using a print
command.

To Print Text
Keypress

You can print the current page or the scrolling region by pressing the F2 key.

To view the options in the Printer dialog box, choose the Options menu, then the
Terminal menu, and then choose Printer from the cascaded menu. Options in the
Printer dialog box affect how VT LAN40 will print the screen display. Select
Page or Region under Extent. Select None or Form Feed under Terminator.
Select a font (or select Automatic) under Font Selection.

You can cancel printing by choosing the Cancel button on the VT LAN40 status
bar.

Command

You can print portions of the VT page(s) using the Print command from the
Session menu. You can choose to print a selected area of the screen, the viewed
portion of the current page (window), the entire current page, or all the pages.

If you have selected an area of the screen, a “Print” button appears on the status
bar. Choosing this button prints the selected text. It is equivalent to choosing the
Print command, with Selection as the Extent.

To print text using the Print command

1. Choose Print from the Session menu, or click the Print button on the
VT LAN40 Toolbar.

     Print button

2. Select one of the options under Extent.
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3. Select Text under Format.

4. Choose OK.

To Print Graphics
Before you display the graphic image that you want to print, you must setup
graphics options so that a graphic image is saved and ready for printing.

Prepare Graphics for Printing

The Backing Store methods allow you to print graphics images from a bitmap of
the screen or from the saved Display List. To allow printing, you must select
one or both of the Backing Store methods, Bitmap or Display List, in the
Graphics dialog box (Options Terminal menu). For details about storing
graphics, see Chapter 3, :How to Set Your Terminal Options."

Print from a Bitmap
The resolution of the printed image is limited by the resolution of the screen
display. Text and graphics are scaled to the same ratio to fill the output page,
maintaining the alignment of text and graphics.

To select bitmap printing

1. Select either (or both) of the options under Backing Store in the Graphics
dialog box.

2. If you selected Display List in the preceding step, select Use Bitmap under
Graphics Printing in the Printer dialog box.

Print from the Display List
VT LAN40 sends Windows graphics drawing commands from the Display List
to the local printer. This method usually produces a higher resolution than the
Bitmap method. However, text and graphics might not be scaled exactly the
same, causing some misalignment between text and graphics on the full-page
output.

If your printer does not support graphics drawing commandsthat is, if Display
List printing does not work for your printertry the Bitmap method.
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To select Display List printing

1. Select the Display List option under Backing Store in the Graphics dialog box.

2. Select the Bitmap option under Graphics Printing in the Printer dialog box.

Print with a Keypress
Printing graphics by pressing the Shift F3 key prints only the displayed portion
of the image.

Options in the Printer dialog box tell VT LAN40 how to print the screen display.
Select None or Form Feed under Terminator.

Options under Graphics Printing in the Printer dialog box allow you to  select
whether to print the background, whether to print in color, and whether to
reverse the light and dark areas of the image.

You can cancel printing by choosing the Cancel button on the VT LAN40 status bar.

Print with a Command
You can print portions of the VT page(s) using the Print command from the
Session menu. You can choose to print a selected area of the screen, the viewed
portion of the current page (window), or the entire current page.

In the Printer dialog box, you can select None or Form Feed under Terminator.

Options under Graphics Printing in the Printer dialog box allow you to  select
whether to print the background, whether to print in color, and whether to
reverse the light and dark areas of the image.

To print graphics using the Print command

1. Choose Print from the Session menu, or click the Print button on the
VT LAN40 Toolbar.

     Print button

2. Select one of the options under Extent. (The All Pages option does not
apply to graphics.)

3. Select Graphics under Format.

4. Choose OK.
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To Delete Accumulated Print Data
VT LAN40 and Windows buffer printer data. For most Windows printers,
closing the printer prints the buffered data, and might eject the page. VT LAN40
gives you two ways of closing the printer: the Close Print Job Idle Timer option
in the Printer dialog box (Options Terminal menu), and the Close Print Job
command on the Session menu.

Close Print Job Idle Timer Option
The timer controls whether VT LAN40 sends your print jobs to a printing device
soon after you request printing, waits for a time-out, or waits until you force
printer output.

For data that arrives quickly, set the timer to a small time interval to ensure that
the printer deletes accumulated data frequently.

For data that arrives slowly, set the timer to a large value. This prints data less
often than a small interval does.

Close Print Job Command
To force output to the printer, you can use the Close Print Job command
(Session menu), or exit from VT LAN40.

Printer Modes

Auto Print
The host controls Auto Print mode. In this mode, the data appears on the screen
and the printer. VT LAN40 prints each line of text from the screen when it
receives a line feed, form feed, or vertical tab. Typically, you use this mode to
log screen data. Usually, VT LAN40 enters Auto Print mode on a control
sequence sent from the host. You can turn the Autoprint feature on manually if
you select Auto Print in the Printer dialog box (Options Terminal menu).

Emulating an ANSI Printer
If the host expects to send data to an ANSI printer in Printer Controller mode,
you can configure the VT LAN40 to accept and print such data.

Select the Emulate ANSI Printer option in the Printer dialog box (Options
Terminal menu). The VT LAN40 translates the data to equivalent Windows
printer commands.
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Printer Controller Mode
In Printer Controller mode, VT LAN40 prints data from the host directly,
without displaying it on the screen (pass-through mode). Normally, the host
selects Printer Controller mode without any user action. However, you can
switch to Printer Controller mode manually by selecting the Controller option in
the Printer dialog box (Options Terminal menu).

Unless you select the Emulate ANSI Printer option in the Printer dialog box, the
VT LAN40 assumes the host is configured for the local attached printer and
sends all data to the printer without translation.

A host might cause the VT LAN40 to enter and exit Printer Controller mode
several times during a print operation, even when printing on the same page.
You can select the Close Print Job Idle Timer option to gather small print jobs
into one larger print job.

Commands for Printing and Printer Options

Print...
The Print command on the Session menu displays the Print dialog box, as
illustrated in Figure 5-1.

Figure 5-1  Print Dialog Box
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The options in this box allow you to select how much of page memory to print.
You can print text or graphics using this command.

You can also display this dialog box by clicking on the Print button on the
VT LAN40 toolbar.

     Print button

The VT LAN40 appends a form feed only if you selected Form Feed under
Terminator in the Printer dialog box. Otherwise, the VT LAN40 does not
append a terminator.

You also can print page memory using the F2 or Printscreen key, depending on
your keyboard. You cannot use this command in Printer Controller mode.

Dialog Box Options

Extent    Specify how much of page memory to print. The selection that you
choose overrides the selection under Extent in the Printer dialog box (Options
Terminal menu). Select from:

Selection   Print the selected area.

Window   Print what appears in the VT LAN40 emulation window.

Page   Print the current VT page. If in 401X mode, print the entire
Tektronix image.

All Pages   Print all VT pages. (Does not apply to graphics.)

Format    Specify whether to print text only, or text and graphics. Select from:

Text   Print text only.

Graphics   Print text and graphics.

Printer...
From the Options Terminal menu, the Printer command displays the Printer
dialog box, as illustrated in Figure 5-2.
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Figure 5-2  Printer Dialog Box

The options in this box allow you to select the printing mode, and other printer
options. Many of the options correspond to those available on a VT terminal.

Dialog Box Options
Mode    Determines when and how printing takes place. In most cases, the host
selects these modes for you.

Normal   Disable continuous printing.

Auto Print   Print the current line of text after receiving an end-of-file, line
feed, form feed, or vertical tab.

Controller   Send data directly to the printer without displaying the data on
the screen.

5-8  Quick Start/Operating Information



    How to Set Up and
Use a Local Printer ...

Close Print Job Idle Timer    Sets the interval of idle time (no data received) after
which VT LAN40 flushes any buffered printer data, and prints the page. This
option handles the timing needs of local printers. It affects all modes of printing:
print screen, auto print, and printer controller modes.

If VT LAN40  has buffered printer data and accumulates no other data during the
timer interval, this option flushes the buffered printer data. This sends the data
to the Windows printing spooler or printing device, and then closes the printer.

When this timer expires, it performs the same function as the Close Print Job
command on the Session menu.

If you set a small timer value for your local printer, the VT LAN40 sends each
print job quickly to the printer. You might want to disable the timer (select
Manual) and use the Close Print Job command on the Session menu to send
accumulated data to the printer. Values are:

2 secs  1 min Manual
10 secs (default)   2 min
30 secs 5 min

Print Screen    Determines the Extent and Terminator for the printing.

Extent    Selects what portion of the VT page prints when you request a print
screen by pressing a key. The VT terminal defines the extent. The host can
control this option. Choose one of the following:

Page   Prints the entire page even if you are viewing only a portion of
that page.

Region   Prints only the scrolling region. Normally, the VT LAN40
defines the scrolling region as the complete page.

Note

The Print command on the Session menu has its own dialog box to
control Extent. Along with Page, it offers All Pages, Selection, and
Window (the current view), which you cannot choose in the Printer
dialog box.
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Terminator    Determines whether or not the VT LAN40 sends a form feed at
the end of the print operation. Select one of the following choices:

None   Sends no form feed.

Form Feed   Sends a form feed, forcing each print to a separate page.

Controller Mode    Prints data from the host without displaying it on the screen.

Emulate ANSI Printer    Translates LA210 ANSI printer sequences to
equivalent printer functions. The VT LAN40 assumes the host sends
LA210 ANSI printer sequences and therefore translates those sequences
to equivalent printer functions.

If you do not select this option, the VT LAN40 assumes the host is
configured for the specific printer attached. The VT LAN40 sends all
data to the printer without translation.

Graphics Printing    Controls how VT LAN40 handles printing of graphics
images. Select one or more of the following choices:

Print background    Prints the current screen background. By default, the
VT LAN40 does not print the background. The background color is the
paper color.

Print colors    Prints colors on a color printer and uses a dithering
technique on a monochrome printer. If you do not select this option, the
VT LAN40 converts all non-white colors to black.

Reverse black and white colors    Swaps the brightest and darkest color
in the palette for printing. Usually, images print as black text on a white
background (because paper is white, and the screen usually is black).

Use bitmap    Uses the bitmap method of graphics printing, regardless of
which backing store method was selected in the Graphics dialog box
from the Options Terminal menu.

Font Selection    Sets the printer font for VT LAN40 to use.

Automatic    Uses a fixed-pitch font. The VT LAN40 selects a font from
the ones supplied by the printer, choosing the one that best fits 80 or
132 columns on the printed page.
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Fonts    Displays the Font dialog box from which you can choose the
font that you want the VT LAN40 to use. This option is available only
if you do not select Automatic.

Font Dialog Box
Figure 5-3 illustrates the Font dialog box with options that allow you to select a
font, style, and size for VT LAN40 to use.

Figure 5-3  Font Dialog Box

Dialog Box Options

Font    Select from the list of your installed Windows fonts.

Font Style    Select Regular, Italic, Bold, or Bold Italic.

Size    Select a font size from the list.

Sample   When you select a font, font style, and size, an alphabet is
automatically displayed that represents the text style that you have requested.
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A
How to Use

VT LAN40 and Windows

This appendix presents some basic mouse techniques and Windows techniques
to help you more easily manage your VT LAN40 terminal.

Terms for Basic Mouse Use
The following table describes some of the terms referred to throughout this
guide when mouse techniques are explained.

Term Meaning

Click To quickly press and release the mouse button.

Double-click To click the mouse button twice in rapid succession.

Drag To hold down the mouse button while you move the mouse.

Point To move the mouse until the mouse pointer on the
screen rests on the item of choice.
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Other Windows Terms
The following list provides terms that are referred to throughout this guide.

Term Meaning

Keyboard
shortcut

Shortcut keys can be used to carry out some menu
commands. Shortcut-key combinations are listed to the right
of a menu item. Instead of opening the menu and choosing a
command, you simply press the key combination.

Select an
item*

Marking he item with the selection cursor, which can appear
as a highlight, a dotted rectangle, or both. You also select
checkboxes in dialog boxes. Selecting alone does not initiate
an action.

Choose an
item*

Carries out an action. For example, choosing an icon might
start an application, open a window, or carry out a command.

You can also choose an item from a menu, or choose a
command button in a dialog box. (Menus and dialog boxes
are discussed in more detail later in this chapter.) You often
need to select an item before you can choose it.

*Sometimes, you can use a combination of mouse and keyboard techniques. For example,

  you could click an item to select it, and then press Enter to choose it.

Use of Your Menus
Commands are listed on menus that are listed on the menu bar along the upper
edge of the application window.

In addition, each application window has a Control menu. The Control menu
opens from the small box in the upper-left corner of each window. For more
information, see "Using the Control Menu" later in this chapter.
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To Select or Close a Menu
Figure A-1 illustrates the selecting of the Session menu and shows the
commands that you can choose from that menu.

Figure A-1  VT LAN40 Menus

In Windows, you select (highlight) a menu and then choose a command from
that menu. When you choose a command, you either carry out an action
immediately or open a dialog box or another menu from which you carry out
one or more actions.

To select a menu

Use either the mouse or the keyboard, as follows:

Mouse

Use either of the following methods:

• Using the mouse pointer, point to the name of the menu on the menu bar
click the left mouse button to open the selected menu.

• Drag the selection cursor down the menu until the menu item is highlighted
and release the mouse button.
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Keyboard

1. Press Alt or F3 to select (highlight) the menu bar.

2. Press the Left Arrow or Right Arrow key to select the menu you want.

3. Choose Enter to open the selected menu.

Tip

If a name in the menu bar has an underlined letter, you can press Alt to
move to the menu bar, and then type the underlined letter to open the
menu. For example, to open the Session menu, press Alt, S.

To close a menu

Use one of the following methods.

• Click the menu name or anywhere outside the menu.

• Press Alt or F10 to cancel the menu and move back to the application
workspace.

• Press Esc to close the menu but remain on the menu bar so that you can
select another menu.
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To Choose a Menu Command
Menu items are usually commands. Figure A-2 illustrates the Options menu for
the VT LAN40, which provides commands that allow you to set and control the
options for sessions with your host.

Figure A-2.  Sample Menu

Menu items can also be characteristics you assign to graphics or text (such as
bold or centered), a list of open windows or files, or the names of cascading
menus, which list additional commands.

To choose an item from a selected menu

Use one of the following methods:

• Click the item.

• Type the letter that is underlined in the item name.

• Use the Up Arrow and Down Arrow keys until you reach the item you want
to select, and then choose Enter.
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Menu Conventions
The following menu conventions are used in Windows.

Menu Convention Meaning

Dimmed (or not visible)
command

You might not be able to use the command with your
application at the current time. (For example, you
might need to select another item before using this
command.)

An ellipsis (...) following a
command

A dialog box appears when you choose the command.
The dialog box contains options you need to select
before the command can be carried out.

A checkmark (ü) to the left
of a command

The command is in effect when you toggle (that is,
when you click to display the checkmark). When you
click on the command again (toggle off, you remove
the checkmark and the command is no longer in
effect.

A key combination to the
right of a command

The key combination is a shortcut for this command.
You can use this key combination to choose the
command.

A triangle ( ) to the right
of a command

When you choose this command, a cascading menu
appears, listing additional commands.

Use of a Control Menu
Application windows, application icons, and some dialog boxes display a
Control menu, as illustrated in Figure A-3.

 Control-Menu box

You open the Control menu for windows and dialog boxes by selecting the
Control-menu box located in the upper-left corner of the window or dialog box.
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Figure A-3  Control Menu

The Control menu for an application window and a dialog box are somewhat
different from each other. The following section describes how to use the
Control menu in these environments.

How to Open the Control Menu
The way in which you open the Control menu depends on whether you are
working with an application window, a dialog box, or an icon.

To open the Control menu for a window or an icon

Use either the mouse or the keyboard, as follows:

Mouse

Use one of the following methods:

• Click the Control-menu box in the upper-left corner of the window.

• Click the application icon.

Do not double-click; because if you do, the window closes or the icon is restored
to a window.

Keyboard

Quick Start/Operating Information  A-7



How to Use
VT LAN40 and Windows ...

1. Press Alt+Esc repeatedly to cycle through the open application windows
and icons until you reach the one you want.

2. Press Alt, Spacebar to open the Control menu. (Press Alt if you want to
close the menu without choosing a menu item.)

To open the Control menu for a dialog box

Use one of the following methods:

• Click the Control-menu box in the upper-left corner of the dialog box.

• Press Alt, Spacebar. (Press Alt to close the menu without choosing a menu
item.)

Control-Menu Commands
The following table describes the commands on the Control menu. Only some
applications have all these commands.

Command Use

Restore Restores the window to its former size after you have enlarged it
(by using the Maximize command) or reduced it to an icon (by
using the Minimize command).

Move Uses the keyboard to move the window to another position.

Size Uses the keyboard to change the size of the window.

Minimize Reduces the window to an icon.

Maximize Enlarges the window to its maximum size.

Close Closes the window or dialog box. (From an application window,
you can use this command to quit the application.)

Switch To... Displays the Open Task List, which allows you to switch between
running applications and to rearrange windows and icons on your
desktop.

Open Session... Opens the Open dialog box, which allows you to either open a
new VT LAN40 session or select and open an existing session.

Open Layout... Opens the Open Layout dialog box, which allows you to either
create a new layout for your session or select and open an existing
layout for your session.
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Command Use

Save Layout... Opens the Save Layout dialog box, which allows you to either
save the layout that is currently open for your session or select and
save a new layout for your session.

Show Menu
Bar

The Menu bar is visible in the window, if Show Menu Bar is
checked. The menu bar is not visible if this command is
unchecked.

How to Work with a Window
When you work with applications, several windows can be open at the same
time. This section explains how to move and resize windows, scroll through
window contents, and arrange windows on the desktop.

How to Change the Size of a Window
You might want to change the size and shape of windows on your desktop. For
example, to compare the contents of two windows, you can reduce the size of
both windows so that they fit side by side. If you are using a mouse, you can
drag the window's border or corners to adjust the size. If you are using the
keyboard, you can modify the window's size and shape by using commands on
the Control menu.

Note

The minimum size for all windows is about 2 inches by 1 inch.  Some
application windows cannot be resized.

To change the size of a window

Use either the mouse or the keyboard, as follows:

Mouse

1. Select the window you want to resize.

2. Point to a border or corner.

3. The pointer changes to a two-headed arrow.

4. Drag the corner or border until the window is the size you want.
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If you drag a border, the window size changes only on the side of the border
you drag. If you drag a corner, the two adjoining sides that form the corner
are moved at the same time. An outline shows the size and shape you are
creating.

5. Release the mouse button.

6. To cancel the resizing, press Esc before you release the mouse button.

Keyboard

Select the window you want to resize and use the following keys, as appropriate.
(Be sure Num Lock on the PC keyboard is turned off.)

Action Description To Perform the Action...

Cycle through application
windows until you reach
the window to be changed.

Press Alt+Tab or Alt+Esc .

Resize an application
window

(Resize continued)

1. Press Alt, Spacebar to open the Control menu.

2. From the Control menu, choose Size.C

3. The pointer changes to a four-headed arrow. Use
an arrow key to move the pointer to the border
you want.

4. Press two arrow keys simultaneously to select a
corner of the window.

For example, press Up Arrow+Right Arrow to
select the upper-right corner of the window.
Use an arrow key to move the border.
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Action Description To Perform the Action...

Change horizontal and
vertical size

If you are changing the size both horizontally and
vertically:

1. Press the Right Arrow key to stretch the
window to the right

2. Press the Up Arrow key to stretch the
window toward the top of the desktop, until
the window is the size you want.

An outline shows the size and shape as you make
changes.

5. Press Enter when the window is the size you want.

Cancel the resizing Press Esc before you press Enter.

How to Reduce a Window to an Icon
When you finish working with an application, you might want to reduce the
application window to an icon if you want the application available for later use.

When you reduce an application window to an icon, the application continues to
run but its window does not take up space on the desktop. You might also be
able to reduce a document window to an icon.

You can select and move icons on your desktop in the same way you select and
move windows.

To reduce a window to an icon

Use either the mouse or the keyboard, as follows:

Mouse

1. Select the window you want to reduce.

2. Click the Minimize button (the box with a down arrow to the right of the
title bar) in the upper-right corner of the window.
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Keyboard

Select the window you want to reduce and use the following keys, as
appropriate.

Action Description To Perform the Action...

Cycle through application
windows until you reach
the one you want

Press Alt+Tab or Alt+Esc .

Reduce an application
window

1. Press Alt, Spacebar to open the Control menu.

2. From the Control menu, choose Minimize.

How to Enlarge a Window
In most cases, you can enlarge an application window to fill a larger portion of
the desktop or even the entire desktop.

A document window can be enlarged to fill an entire application window except
the menu-bar area.

To enlarge a window to its maximum size

Use either the mouse or the keyboard, as follows:

Mouse

1. Select the window you want to enlarge.

2. Click the Maximize button in the upper-right corner of the window.

Note

You can also maximize a window by double-clicking its title bar. To
restore an application window to its previous size, double-click the title
bar again. Click the Restore button in the upper-right corner of the
window.
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Keyboard

Select the window you want to enlarge and use the following keys, as
appropriate.

Action Description To Perform the Action...

Cycle through application
windows until you reach
the one you want

Press Alt+Tab or Alt+Esc .

Enlarge an application
window

1. Press Alt, Spacebar to open the Control menu.

2. From the Control menu, choose Maximize.

How to Use Scroll Bars
Some windows and dialog boxes have scroll bars that you can use to view
information that exists beyond the borders of the window. When you can view
all the contents of a window or dialog box without scrolling, scroll bars might be
absent or dimmed to indicate that they cannot be used.

To scroll through information displayed in a window or dialog box

Use either the mouse or the keyboard, as follows:

Mouse

Use either of the following methods.

• Drag the scroll box to scroll through all the information in a list or
document.

• Use the following techniques to scroll. (Be sure Num Lock on the PC
keyboard is off.)
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Type of Scrolling To Perform  the Action...

One line up or
down

Click the up or down scroll arrow.

One screen Click the scroll bar above or below the scroll box on vertical
scroll bars, and to the left or right of the scroll box on
horizontal scroll bars.

Continuously Point to one of the scroll arrows, and hold down the mouse
button until the information you want comes into view.

To any position Drag the scroll box in the scroll bar to the position you want.
The section of the document or list that moves into view
depends on where you position the scroll box. For example, if
you position the scroll box halfway down the vertical scroll
bar, the text halfway through the document or list appears.

How to Close a Window
One way to quit an application is to close the application window. Similarly,
you can close a session by closing the session window.

If you changed your session since you last saved it, a message prompts you to
save the session before closing the window.

Use any of the following methods to close a window:

• From the File menu, choose Exit.

• Choose Close from the Control menu.

• Double-click the Control-menu box.
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Use of a Dialog Box
Figure A-4 illustrates a sample of a VT LAN40 dialog box. A dialog box
provides options from which you can request information about a task you are
performing or supply information you might need.

Figure A-4  Dialog Box Example

Most dialog boxes contain options that you can select. After you specify options,
you can choose a command button to carry out a command.

Other dialog boxes might display additional information, warnings, or messages
indicating why a requested task cannot be accomplished.

Some dialog boxes contain an ellipsis (...) after a menu command to indicate
that another dialog box will appear when you choose that command.
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To Move Within a Dialog Box
Often you need to move within a dialog box to select one or more options. The
currently selected option is marked by the selection cursor, which appears as a
dotted rectangle or a highlight.

To move within a dialog box

Use either the mouse or the keyboard, as follows:

Mouse

Click the option or area you want to move to.

Keyboard

Use either of the following methods (Be sure Num Lock on the PC keyboard is
turned off.):

• Press Tab to move forward (generally from left to right and top to bottom),
or press Shift+Tab to move in the opposite direction.

• While you press and hold down Alt, type the letter that is underlined in the
option name or group name.

• Within an area, use the arrow keys to move from one option to another.

Command Buttons
You choose a command button to initiate an immediate action, such as carrying
out or canceling a command.

• The OK and Cancel buttons are common command buttons. They are often
located along the bottom or on the right side of the dialog box.

• A command button followed by an ellipsis (...) opens another dialog box
that expands the active dialog box.

For example, the Color... command expands to allow you to change the
color attributes. When you choose Color from the Options menu, the Color
dialog box displays all the color attribute options.

• Unavailable buttons are dimmed.
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• The currently selected button has a darker border than other buttons. You
can choose the selected button simply by pressing Enter.

To close a dialog box without completing a command, choose the Cancel button
or press Esc.

To choose a command button

Use either the mouse or the keyboard, as follows:

Mouse

Click the command button.

Keyboard

1. Press Tab to move to the button you want.

A dark border marks the selected button.

2. Press the Spacebar or Enter.

Tip

If the button has an underlined letter in its name, you can choose the
command button in one step. Press and hold down Alt while typing the
underlined letter.

Types of Dialog Box Options
The types of options in a dialog box are described in the following sections.

Text Boxes
You type information into a text box.

When you move to an empty text box, an insertion point (blinking vertical bar)
appears at the far left side of the box. The text you type starts at the insertion
point.

If the box you move to already contains text, this text is selected, and any text
you type replaces it. You can also delete the existing text by pressing Delete or
Backspace.

To select text in a text box
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Use either the mouse or the keyboard, as follows:

Mouse

Use either of the following methods:

• Drag the pointer across the text you want to select.

• Double-click on a word to select one word at a time.

Keyboard

Use the following method (Be sure Num Lock on the PC keyboard on the PC
keyboard is turned off.):

1. Use the arrow keys to move to the first character you want to select in the
box.

2. To extend the selection, press and hold down Shift while pressing the
appropriate arrow key. (Press Shift+Home to extend the selection to the first
character in the box. Press Shift+End to extend the selection to the last
character in the box.)

List Boxes
A list box displays a list of choices. If there are more choices than can fit in the
box, scroll bars display along the bottom and/or the side of a window so that you
can move  quickly through the list. For information about scrolling, see "Using
Scroll Bars" earlier in this appendix.

Usually, you can select only one item in a list box.

To select a single item from a list box

Use either the mouse or the keyboard, as follows:

Mouse

Use either of the following methods:

• Click the scroll arrows until the item you want to select appears in the list
box.

Click the item, and then choose the appropriate command button.

• Double-click the item to select it and complete the command all in one step.

Keyboard
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Use either of the following methods (Be sure Num Lock on the PC keyboard is
turned off.):

• Use the arrow keys to scroll to the item you want.

• Type the first letter of the item you want to select. The  selection cursor
moves to the first item that starts with that letter.

Press ENTER.

Sometimes you can select more than one item in a list box, whether or not those
items are sequential. In these cases, you can select or cancel as many items as
you want.

Drop-Down List Boxes
A drop-down list box appears initially as a rectangular box with the current
selection marked by the selection cursor. When you select the arrow in the
square box at the right, a list of available choices appears. If there are more
items than can fit in the box, scroll bars are provided.

This type of list box is often found in small or crowded dialog boxes.

To open a drop-down list box and select an item

Use either the mouse or the keyboard, as follows:

Mouse

Use either of the following methods:

• Click the arrow at the right of the box to open the box.

Click the up or down scroll arrow.

• Drag the scroll box to move to the item you want to select.

Click the item.

Keyboard

Use the following method (Be sure Num Lock on the PC keyboard is turned off.):

1. Press Alt+Down Arrow to open the box.
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2. Press the Up Arrow or Down Arrow key to move the selection cursor to the
item you want.

3. Press Alt+Up Arrow or Alt+Down Arrow to select it.

Option Buttons
Option buttons represent mutually exclusive options. You can select only one
option at a time.

The selected option button contains a black dot. Unavailable options are dimmed.

To select an option button

Use either the mouse or the keyboard, as follows:

Mouse

Click the option button.

Keyboard

Use the following method:

1. Press Tab to move to the group of options you want.

2. Use the arrow keys to select the option button you want.

Tip

If the option has an underlined letter, you can select the option button
by pressing and holding down Alt while typing the underlined letter.

Check Boxes
A check box next to an option indicates that you can select or clear the option.
You can select as many check-box options as needed. When a check box is
selected, it contains an X. Names of unavailable options are dimmed.

Note

In some cases, a check box might be shaded. A shaded box often
signifies that additional choices relate to the option, though the
meaning varies with the application.
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To select or clear check boxes

Use either the mouse or the keyboard, as follows:

Mouse

Use the following method:

1. Click each blank check box you want to select.

2. Click a selected box to clear it.

Keyboard

Use the following method:

1. Press Tab to move to the check box you want to select or clear.

2. Press the Spacebar to select the box.

3. Press the Spacebar again to clear the selection.

Tip

If the option name has an underlined letter, press and hold down Alt
while typing the underlined letter to select or clear the check box.
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How to Make a Connection

The first part of this appendix provides forms and procedures to help you to
complete your network setup, if your VT LAN40 terminal is connecting to a
TCP/IP and/or a DECnet network.

The remainder of this appendix provides information about establishing a
communications configuration, making a connection, and controlling the
sessions with your host.
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TCP/IP Setup Procedures
Before you begin network setup

1. Collect necessary network information for connecting to TCP/IP.

2. Record information in the blank lines on the following form.

TCP Data

TCP/IP
Host Name________________________________

IP Address________________________________

Subnet Mask______________________________

Default Gateway___________________________

Domain  Name Resolver

Domain__________________________________

Name Server 0____________________________

To complete the setup

3. Select the TCP/IP button from the Configuration Options dialog box.

4. Enter the TCP/IP setup information in the TCP/IP dialog box.

5. Choose OK to complete the network setup or Cancel to return to the
Configuration Options dialog box.
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DECnet Setup Procedures
Before you begin network setup

1. Collect necessary network information for connecting to DECnet.

2. Record information in the blank lines on the following form.

DECnet Data

Executor

Name____________________________________

DECnet Address___________________________

Nodes

Name____________________________________

DECnet Address___________________________

To complete the setup

3. Select the DECnet button from the Configuration Options dialog box.

4. Enter the name and address assigned to this terminal.

5. For each DECnet node that you wish to connect, choose the Add button and
type each node name and address.

Choose OK to complete the network setup or Cancel to return to the
Configuration Options dialog box.
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The Communications Setup
Before communicating with a host computer, you must establish a valid
communications configuration. VT LAN40 supports many communications
methods, from serial connections—as the VT terminal does, to network
connections such as LAT and TCP/IP.

You select your communications method from the list under Port in the
Communications dialog box.

You can select additional configuration information for the methods by choosing
the Setup button to display the associated dialog box. VT LAN40 supports the
following communications methods:

• Serial
• Serial Multisession
• LAT
• Telnet
• CTERM

These communications methods allow you to have more than one session on the
screen at the same time. Your hardware or network software might restrict the
number of sessions you can run.

For example, if you use a Serial port, you can run only one session at a time on
each COM port. If you want to run multiple sessions, you could configure each
one to a different COM port, or use the Serial Multisession method. However, if
you use a LAT network connection, the network software allows you to connect
to the same or different host services with multiple VT LAN40 sessions.
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Communications
When you start the VT LAN40 for the first time, you must select a
communications method. The VT LAN40 supports the serial (COM) ports,
Serial Multisession, Telnet, LAT, and CTERM connections.

To select and configure a communications port:

1. Choose Communications from the Options menu.

The Communications dialog box appears, as illustrated in Figure B-1.

Figure B-1  Communications

The options in this dialog box allow you to  choose a port for communication
with the host and to access the setup dialog box appropriate for that port.

Dialog Box Options

Port    Select the communications method you want to use to connect to the host
system. VT LAN40  sets this option to None during installation. Select one of
the following:

Serial   Access the COM ports on your PC. The Serial Setup dialog box
allows you to select the particular COM port, and set the port parameters.
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Serial Multisession   Use a protocol that allows multiple sessions on a single
serial port.

The Multisession Serial Port Setup dialog box allows you to select the port
and set parameters.

LAT   Use the Local Area Transport network protocol for terminal access
over Ethernet.

Telnet   Use for terminal access to hosts using TCP/IP.

CTERM   Use wide area DECnet network.

Limit Transmit Rate    Select rate limiting during normal terminal emulation,
pasting, and read operations. This option does not affect protocol-controlled file
transfers such as Kermit or the baud rate.

In many cases, hosts can transmit data faster than they can receive it. Sending
large amounts of data to the host with commands such as Paste can cause data
loss. This option prevents a loss of data Transmit Rate in the Communications
dialog box (Options menu).

Rate (ch/sec)    Set the maximum transmit rate in characters per second for the
VT LAN40 to use when sending data to the host. The default rate is 240
characters per second.

Setup    Display the Setup dialog box for the communication method you
selected in the Port field.

2. Select a communication method from the list under Port. Use the scroll bar
to access the complete list.

3. Choose the Setup button, if available, to display a dialog box that contains
options for the selected port. For a serial port, this dialog box allows you to
set hardware parameters such as baud rate. For a network port, this dialog
box allows you to choose the network service.

4. Choose OK after making any necessary changes.

5. Choose OK in the Communications dialog box.
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Connection Menu Commands
Figure B-2 illustrates the Connection menu that contains commands that control
and affect a session with your host.

Figure B-2  Connection Menu

Menu Options

Connect    Connects to the configured port. You can use this command only if
the VT LAN40 is not already connected.

Disconnect    Disconnects the VT LAN40 from the configured port.

Auto Connect    Connects automatically to the configured port when you start VT
LAN40.

Phone...    Uses your modem to dial a selected number from your personal
dialing directory.

Local    Prevents the VT LAN40 from sending data to the host. Instead, the VT
LAN40 only displays characters on your screen (local display).

Clear    Removes the information displayed in the emulation window from
display memory. This clears the screen. It also sets all line attributes to normal.
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Clear Comm    Clears the communications buffers. Also removes any blocks to
sending or receiving data.

Reset    Returns the terminal to its power-up state. This affects only the ANSI state.

Enable History    When checked, saves information that is scrolled off the VT
screen in the History buffer.

Clear History    Clears the contents of the history buffer.

Connect
The Connect command on the Connection menu connects the VT LAN40 to the
communications port you configured. This command is only available when VT
LAN40 is not already connected. You also can use the Connect button on the
Status Bar.

Disconnect
The Disconnect command on the Connection menu disconnects the VT LAN40
from the current communications port.

The VT LAN40 optionally performs a disconnect when you exit.

Auto Connect
The Auto Connect command on the Connection menu connects the VT LAN40
to the configured port when you start the VT LAN40 or when you change the
port type or network address.

If you disconnect a network connection with Auto Connect allowed, VT LAN40
prompts you about re-connecting to the network.

When you change your network service or port, VT LAN40  disconnects, then
reconnects to the new selection.

If you do not have Auto Connect selected, you must use the Connect command
to make a network connection to the configured port.

Clear Comm
To clear the communications port, choose the Clear Comm command from the
Connection menu. This command empties the communications buffers, clears
any conditions that could prevent transmitting or receiving data (for example,
Xoff received), and cancels any current escape sequence processing.
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Connection Setup
You must configure the serial port to the appropriate setting for your
environment. The VT LAN40 supports baud rates up to 115,200 baud.

Procedures for Port Setup
Figure B-3 illustrates the Serial Port Setup dialog box that is used to specify the
parameters for a serial port.

To display a Setup dialog box

1. Choose Communications from the Options menu.

2. Select the type of port.

3. Then choose Setup.

Figure B-3  Sample Setup Dialog Box
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Dialog Box Options

Port    Select the COM port to use. The VT LAN40 supports COM1 and COM2

    COM1   COM2

Baud Rate    Specify the rate, measured in bits per second, at which the terminal
communicates with the host system. The VT LAN40 uses a default rate of 9600.
Select one of the following choices:

300 1200 2400 4800 9600
19200 38400 57600 115200

Data Bits    Specify the number of data bits for each character. Use 8 if you set
Parity to None, or 7 if you set Parity to a value other than None. The VT LAN40
uses a default of 8 data bits. Select one of the following choices:

7   8

Stop Bits    Specify the time interval between each transmitted character. Select
one of the following choices:

1   1.5   2

Parity    Select the type of error checking. If you set Data Bits to 8, specify None.
Select one of the following choices:

none   even   odd   mark   space

Check Parity    Check incoming parity.

Flow Control

None   No action taken. This can result in loss of transmitted data.

Xon/Xoff   (Default) Pauses when buffer fills, then sends a signal to a remote
computer when ready to receive more data. Generally, the best selection for
communicating with most host computers.

Hardware   Remote system controls the flow of data. Often applicable to
situations where the baud rate between your computer and a
communications device, such as a modem, differs from the baud rate
between the modems. Usually encountered when using modems that use
compression and error correction techniques such as V32bis, V42, or
V42bis standards.

Receive Xoff Point    Specifies how much data can accumulate in the VT LAN40
receive buffer before the VT LAN40 sends an Xoff requesting the host to stop
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sending data. The VT LAN40 uses a default of 1024 (the maximum). You might
want to reduce this value if the VT LAN40 appears to react slowly to a hold
screen, or an interrupt to your host.

Modem Disconnect    Disconnect the session by lowering the DTR signal for
about two seconds if no DSR or DCD activity occurs for the specified time
period.

This generally disconnects the session, as most modems hang up the line when
this happens. However, refer to your modem documentation if you have any
questions about this effect. If your modem cannot drop DSR or DCD, or your
serial cable does not present the signals to the VT LAN40, it might not
recognize the line drop. Select from:

60 ms 2 sec Never

Disconnect on Exit    Drop the modem DTR signal when VT LAN40 exits (the
default). Normally, the modem disconnects. If you do not select this option, the
DTR signal remains high after the VT LAN40 exits, and the modem stays
connected.
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Specifications

Proper Setup and Use
Certain recent scientific literature suggests that poor posture, work habits, or
office equipment setup might cause injuries. Other literature suggests that there
is no cause and effect. Because the safety of our users is a great concern, it is
important to take the precautions described in Table C-1.

If you experience pain or discomfort while using the terminal, take a substantial
break and review the instructions for posture and work habits. If your pain or
discomfort continues when you resume using the terminal, discontinue use and
report the condition to your job supervisor or physician.
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Table C-1  Recommendations for Proper Setup and Use

Adjust So that your ...

Chair 1. Feet are flat on the  floor or  footrest,  if needed.

2.  Legs are vertical forming a right angle to the floor.

3. Weight is off your thighs and are in a horizontal position. Keep the back of
    your knees away from the seat so you do not compress the area behind them,
    which could restrict the blood flow.

4. Upper body is erect and your lower back is supported with a backrest.

Keyboard
and
Mouse

5. Wrists are straight and do not flex more than 15°. They may be supported
     but should not rest on sharp edges.

6. Keep your upper arms straight down at your sides, elbows close to your sides
    to support your arm weight. Forearms should be at a 70° to 90° angle.
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Table C-1  (Cont.) Recommendations for Proper Setup and Use

Adjust So that your ...

Head 7. Avoid neck strain. Your head should incline downward, but no more than
    15° to 20°.

Terminal 8. Keep eye level and the correct distance for proper vision.

Eyes 9. Avoid eye fatigue, which can be caused by glare, image quality, uncomfortable
    furniture, eye height, and uncorrected vision. If you cannot read the screen at
    different distances, you may need special glasses. Relax your eyes periodically
    by looking at distant objects.

Adjust To...

Work
Breaks

Take periodic work breaks. Morning, lunch, and afternoon breaks meet most
recommendations. Take advantage of work breaks to move around and do other
movements.

Lighting Avoid direct lighting or sunlight on the screen, which causes glare and reflec-
tions. The terminal screen has an antiglare treatment to reduce glare. Place
lighting behind or to the side of your work area, and distribute the lighting evenly
on your work area. Adjust the terminal brightness and the contrast controls as
needed.

Noise Keep background noise at a minimum. Background noise above 65 dBA is tiring.
Sound-absorbing materials, such as curtains, carpeting, and acoustic tile, can help
reduce background noise.

Temperature 20°C to 23°C (68°F to 74°F).

Humidity 30% to 70%.

Ventilation Provide adequate air ventilation for equipment operation and to avoid fatigue.

Space
between
terminals

More than 70 cm (28 in) center to center, preferably more than 152 cm (60 in).
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System Unit

Table C-2 provides specifications for the system unit.

Table C-2  System Unit Specifications

Dimensions

Height
Width
Depth

With Stand

34.3 cm (13.5 in)
13.3 cm (5.25 in)
33.0 cm   (13.0 in)

Without Stand

7.0 cm (2.75 in)
31.8 cm (12.5 in)
33.0 cm (13.0 in)

Weight 4.5 Kg (10.0 lbs) 4.1 Kg (9.0 lbs)

Operating Systems
Supported

UNIX, OpenVMS, DEC OSF/1, ULTRIX, or any other that supports the
ANSI protocol.

Emulations ANSI (VT 340/420/320/220/100).

Character Set
Support

Multiple languages using ISO; Windows commands selectable in four
languages.

Productivity
Features

Local copy and paste.
Time of day clock.
Desktop calculator.
Desktop calendar.

ROM Cartridge Operating system, Windows, and  emulation are shared on the card
located behind a door in the front of the unit.

Electrical
Requirements
   AC input voltage
   Line frequency
   Power

100 to 240 VAC full range, single phase, 3-wire.
47 Hz to 63 Hz.
Power consumption 30 watts maximum.

Operating
Temperature

10°C to 40°C (50°F to 104°F).

Humidity 10% to 90% relative humidity.
Maximum wet bulb = 28°C.
Minimum dew point = 2°C (noncondensing).
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Monitor Requirements
The terminal requires a monitor that supports VGA resolution or higher, with a
15-pin, D-Sub connector.

Keyboard
The terminal is designed to support industry-standard PS/2 compatible
keyboards.

Keyboards from some manufacturers might not function correctly due to
differences in their implementation of the standard.

Table C-3 provides keyboard specifications for the VT LAN40.

Table C-3  Keyboard Specifications

Keyboard style LK411/412 for ANSI style layout; PCXAL for enhanced
PC 101/102 style layout; available for most European
languages.

Protocol IBM enhanced PS/2-compatible

Connector PS/2-style, 6-pin mini DIN

Keyboard keys All keys are programmable for single characters, character
sequences, or local functions.

Compose Compose characters are available in:
Multinational, ISO Latin 1, and National Replacement
character sets (NRCS) for the following VT keyboards:
Canadian-English, Canadian-French, Danish, Dutch, French,
Finnish, Flemish, German, Italian, Norwegian, Portuguese,
Spanish, Swedish, United Kingdom, and United States
keyboards.

Nonvolatile
memory 256K bytes memory
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Standards Conformance
Acoustic Noise Preliminary declared values per ISO 9296 and ISO 7779 /DIN
EN27779:

______________________________________________________
Sound Power  Level Sound Pressure Level[2]

 LwAd, B  LpAm, dBA

 Product[1] Idle Operate Idle Operate
______________________________________________________
Terminal <3.3 <3.3 <21 <21
______________________________________________________
[1] Current values for specific configurations are available from service
    representatives. (1 B = 10 dBA.)

[2] Operator position.

Table C-4 provides standards conformance and approvals for the VT LAN40.

Table C-4  Standards Conformance and Approvals

Type Standard Subject

Communications NET 2 test report Australia PTT
Germany PTT
Japan PTT
Sweden PTT

EMI/RFI CISPR-22 Class B

CSA 108.8

FCC part 15 Class B

CE Class B(EN55022
Class B, EN50082-1
Class 1)  EN60555-2
ITE Class 2 (Japan)

Electromagnetic compatibility

DOC Canada North American Class B version

Electromagnetic compatibility

Radio Protection Mark
CE label
VCCI Electromagnetic compatibility

Energy "Energy Star" EPA Energy Star requirements

Ergonomic ZH1/618, GS-VS- SG7 TÜV Ergonomic Requirements

C-6  Quick Start/Operating Information



Specifications ...

Table C-4  (Cont.) Standards Conformance and Approvals

Safety      CSA 22.2 #950 M1989

AS/NZS3260

TÜV EN60950 (IEC
950)  2nd ed (1988)
EN60950
(Amd 1 & 2, 1990)

VDE0805 and Amd

EMKO-TSE (74-SEC)
203/92, DEMKO,
FIMKO, NEMKO,
SEMKO

UL 1950 (2nd ed)

Safety of Information Technology Equipment
Including Electrical Business Equipment
(Canada)

Australia product safety

Safety of Information Technology
Equipment Including Electrical Business
Equipment

GS-Mark (Geprüfte Sicherheit)

Nordic Country Approvals

Safety of Information Technology Equipment
Including Electrical Business Equipment

Specifications
EMI Requirements for Canadian Market:  This equipment does not exceed
the Class B limits for radio noise emissions from digital apparatus as set out in
the Radio Interference Regulation of the Canadian Department of
Communications.

Ergonomic
This product meets TÜV and GS ergonomic requirements.

Flame Retardants
The thermoplastic enclosures do not contain polybrominated diphenylether
(PBDE) as a flame retardant additive; therefore, they do not emit toxic
dibenzofuran and dibenzodioxin gases.
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PVC
The plastic enclosures are not made of rigid PVC. The material has a non-
halogenated, flame-retardant system and is cadmium free.

Asbestos
Asbestos is not used in this product or in its manufacturing process.

Ozone Depleting Substance
The terminal is in full compliance with the labeling requirements in the U.S.
Clean Air Act Amendments of 1990. It does not contain, nor is it manufactured
with, a Class 1 ODS, as defined in Title VI Section 611 of this act.

Environmental
This product has been designed and manufactured to achieve environmental
compatibility and minimize the impact to the environment.

Power Saver
This product is in full compliance with the Video Electronics Standards
Association (VESA) requirements for Display Power Management Signaling
(DPMS)[TM] proposal. After a user-selectable period of idle time, this device
automatically signals the display circuits to reduce power.

Battery Disposal
Recycle or dispose of batteries contained in this product properly, in accordance
with local regulations for the battery type as marked on the battery. Prior to
disposal or recycling, protect batteries against accidental short circuiting by
affixing non-conductive tape across battery terminals or conductive surfaces.

For more information, consult your nearest Digital Service Center.

Keep small batteries away from children.

Replacement of Batteries
When batteries are replaced, use only batteries which are compatible with the
product's electrical requirements and recharging circuitry, if applicable. Consult
your local Digital Service Center for information and proper servicing.
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Lithium Batteries

If this is a Lithium battery, the following precautions apply:

Caution

Danger of explosion if battery is incorrectly replaced.
Replace only with same or equivalent type recommended by the
manufacturer. Dispose of used batteries according to the manufacturer's
instructions. Consult the product user manual or service manual for
replacement instructions, or consult your local Digital Service Center.

Power Cord Information

Table C-5 provides power cord information for the VT LAN40.

Table C-5  Power Cord Information

Country Order Number AMP Length

Australia, New Zealand BN19H-2E 10A 3.5 m

U.S., Canada, Japan BN19P-2E 10A 3.0 m

Netherlands, Norway, Turkey, Hungary,
Czech, Poland, Romania, Russia, Latin
America, Belgium, Germany, Sweden, Spain,
Portugal, Finland, Greece, France

BN19C-2E 10A 2.5 m

Denmark BN19K-2E 10A 2.5 m

Italy BN19M-2E 10A 2.5 m

United Kingdom BN19A-2E 10A 2.5 m

Switzerland/French
Switzerland/German

BN24T-2E 10A 2.5 m

Israel BN18L-2E 10A 2.5 m

India, South Africa BN19S-2E 10A 2.5 m
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Troubleshooting and

Operating Tips

Appendix D provides information about the power-up self-test, error messages,
troubleshooting, and operating tips for the VT LAN40.

Power Up Selftest
During the VT LAN40 power-up sequence, while the system power-up self-test
is occurring, the terminal displays the message:

Self test in Progress - Please Wait...

If the test is successful, the terminal displays the VT LAN40 Control Center. If a
problem occurs, an error message displays.

Table D-1 provides the error messages that can display during power up.
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Table D-1  Self-Test Error Messages

Error Message Corrective Action

Terminal battery has failed. Contact an
authorized service representative.

The terminal stores its settings in battery-
refreshed memory. If the battery fails, it
must be replaced by an authorized service
representative. The battery is not a user-
serviceable part.

Keyboard Error. Check keyboard or contact
an authorized service representative.

The keyboard is either not attached or is
defective. Turn off the terminal, and verify
that the keyboard is properly connected.

Do not confuse the mouse connector with
the keyboard connector. The connectors
look identical, but they are different and are
clearly marked.

Self test has failed. Contact an authorized
service representative.

One of the self tests performed by the
terminal has failed. Contact an authorized
service representative to repair the terminal.

Turn off terminal and insert a ROM card. In order for the terminal to operate properly,
a ROM card must be inserted in the front of
the unit, as follows:

1. Turn the terminal off.

2. Verify that the card is inserted properly

and is firmly seated in its socket.

3. If the problem continues, try another

ROM card.

4. If the message persists, then contact

an authorized service person.
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Table D-1  (Cont.) Self-Test Error Messages

Error Message Corrective Action

Non-volatile memory has been initialized. If
this always occurs, contact an authorized
service representative.

This message is displayed when the
system settings have changed, usually due
to the insertion of a new or updated ROM
card or when factory defaults are restored.

Turn the terminal off, then on. If the
message persists, contact an authorized
service representative to have the SRAM
battery replaced. The SRAM battery is not
user-serviceable.

SRAM card is missing or damaged. Contact an authorized service
representative to install or replace the
SRAM card.

Troubleshooting
Table D-2 identifies problems that affect VT LAN40 operation and solutions for
correcting those problems. The first column in Table D-2 summarizes problem
symptoms and possible causes; the second column describes solutions.

Table D-2  Troubleshooting: Problems and Solutions

Problem Solution

Terminal operation appears to
stop.

Cause: Selection is in progress.

Cancel the selection, or press CTRL-Q.

All terminal operations in the window are suspended
while a selection is in effect. The selection appears as
inverse or highlighted text. During selection, the "stop
light" on the Toolbar is red. To cancel the selection,
use any of the following procedures:

• Click the left mouse button in the window.

• Click on the "stop light" in the Toolbar.

• Hold down the Control key and press "Q".

Quick Start/Operating Information  D-3



Troubleshooting and
Operating Tips ...

Table D-2  (Cont.) Troubleshooting: Problems and Solutions

Problem Solution

The printer will not print.

Cause #1: The printer port is set
incorrectly.

Cause #2:  Incorrect serial port
selected.

Click on Control Center to display the Control Panel
application.  Double click on the Ports application.  In
the Ports dialog box, select the serial port used for
printing and set corresponding printer values.

Note

If an incorrect BAUD rate is selected and an attempt
is made to print, terminal operations can stop. To
resume operations, you must turn the terminal off.

Click on Control Center to display the Control Panel
application.  Double click on the Printers application.
In the Printers dialog box, choose Connect.  Choose
either COM1 or COM2, whichever is appropriate.

Terminal operations appear to
stop during printing.

Cause #1:  Wrong BAUD rate
selected on serial port.

Cause #2: Conversion from the
Display list is slow.

When printing to a serial port, ensure that the correct
BAUD rate and other settings are selected from the
Ports dialog box in the Control Panel.  See the first
explanation in the previous error description.

The terminal can print graphics in one of the following
ways:

• The Bitmap method, which transfers a bitmap

from the screen to the printer.

• The Display List method, which translates the

image on the screen into drawing primitives.

When you use the Display List method, some
images, especially Sixel images, take a long time to
translate because they consist of pixels rather than
lines.  You can increase the print speed by changing
to bitmap printing. However, if you use bitmap
printing, the printed image size is usually much
smaller than the image that prints when you use the
Display List printing option.

To use the Bitmap printing method

1. From the Options Terminal: Graphics dialog

box, under the heading "Backing Store",

deselect "Display list".

2. Select "Bitmap".

3. Redisplay your graphics.

D-4  Quick Start/Operating Information



Troubleshooting and
Operating Tips ...

Table D-2  (Cont.) Troubleshooting: Problems and Solutions

Problem Solution

The screen is blank, but power is
on.

Cause: The Power Management
feature is active.

Press any key on the keyboard. The monitor might
need time to warm up.

Colors move on the screen, or the
display might be distorted,
flickering, or rolling.

Cause: Electromagnetic
interference is coming from other
appliances.

Press the degauss switch on the monitor. If color
problems persist, then electromagnetic interference
exists. Move any electromagnetic device away from
the terminal, or move the terminal.

Cannot disable the screen saver
password.

Cause: Use of the System dialog
box instead of the Desktop dialog
box.

The terminal uses the following two passwords:

• The Control Center password (accessed from

the Control Center Configuration dialog box).

• The screen saver password (which causes the

screen saver to remain active until the correct

password is entered and is accessed from the

Control Panel).

Select the Desktop application in the Control Panel to
set the screen saver password.

Error message: "Insufficient
memory for display list growth,
image data will be lost"

Cause: Too many windows are
active.

Close some windows or reduce the memory
requirements for the open windows.

The terminal maintains a "copy" of the screen in
memory. When a window is placed on top of another
window and then removed, any graphic images on
the uncovered window are restored from the off-
screen copy. This off-screen copy might require a lot
of memory. If you attempt to create many sessions,
the terminal frees its off-screen memory so that more
sessions can be created.  However, because this
memory is freed, the terminal cannot automatically
redisplay the graphic images.  Instead, you have to
enter a request to the host to redraw the graphic
images that you wish to redisplay.

Error message: "Insufficient
memory for bitmap store"

Cause: Too many windows are
active.

Close some session windows. See the explanation in
the previous error description.
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Table D-2  (Cont.) Troubleshooting: Problems and Solutions

Problem Solution

Desktop pattern feature does not
work.

Cause: The "wallpaper" feature is
active.

In the Desktop application on the Control Panel,
select (None) for the "wallpaper" type.

Use of the copy and paste feature
yields unexpected results.

Cause: Optimal copy and paste
methods are not being used.

See the Operating Tips section at the end of this
appendix for details about optimizing use of the copy
and paste features.

Cannot copy and past when the
Toolbar and menu are disabled.

Cause: Copy and past buttons are
not visible.

See the Operating Tips section at the end of this
appendix for details about additional copy and paste
methods.

Remote system cannot identify the
terminal type.

Cause: A conflicting terminal
mode and DA response exist.

Choose the Options Terminal General menu. In the
General dialog box, check that the DA response
option is appropriate for the terminal mode selected.

For example, the DA response VT102 might be
selected for the mode VT340/420 8-bit.  However,
because VT102 cannot be 8-bit, an OpenVMS system
performing a SET TERM/INQUIRE command will fail
to identify the terminal. In this case, choose
7-bit.

Error messages display that make
references to processes that are
not visible to the user.

Cause: Memory resources are low
or depleted.

Observe the system resource meter (Sysmeter) to
determine if memory is low, and then close
applications, as needed, to restore memory levels.

When memory resources are very low, the terminal
might issue error messages that refer to internal
system operations. You can determine if memory is
low by observing the Sysmeter icon (usually
displayed in the lower left corner of the terminal). If
the bar color displays either yellow or red, or the bar
has disappeared, then memory is critically low.

Close unneeded applications, or, to reduce memory
utilization, see the Operating Tips section in this
appendix for information about memory management.

Sysmeter turns yellow or red.
Cause: Too many applications are
running.

See the Operating Tips section in this appendix for
information about memory management.
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Table D-2  (Cont.) Troubleshooting: Problems and Solutions

Problem Solution

The terminal does not save the
clock settings.

Cause: Settings have not been
saved.

Save the clock settings by closing the clock
application or by shutting down the terminal.

Since some of the applications do not have an option
for saving settings, settings for those applications are
saved only when that application is closed or when
the terminal is shut down.

To ensure that settings are saved, use one of the
following methods:

• Choose the Shutdown command from the

System menu (displayed when you click on the

Control-menu box in the upper left corner of the

Control Center).

• Close the application using one of the following

methods:

- Double click on the Control-menu bar in the

upper-left corner of the application.

- Single click on the Control-menu bar for an

application.

- Choose the Close command when the

Control menu for that application displays.

• If the application does not display a Control-

menu bar or title bar, press the Alt Tab key to

transfer focus to the application.

Press the Alt F4 key.

Some keys do not work properly
or are not present.

Cause: Key mapping conflicts
exist.

See the Operating Tips section at the end of this
appendix for details about how to remap keyboard
keys.
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Table D-2  (Cont.) Troubleshooting: Problems and Solutions

Problem Solution

Typed characters are lost after the
screen saver disappears from the
display.

Cause: Focus is not on the
desired application.

Set the focus to the desired window by clicking
anywhere in that window.

When the screen saver is deactivated, focus might
return to a different application than is expected. Click
anywhere in the desired window, or use Alt Tab to
return focus to the desired application window.

Video display has a visible flicker
or is unreadable.

Cause: The video refresh rate is
set incorrectly.

Use the Set Resolution application from the Control
Panel to specify a new refresh rate.

Note

The terminal must restart for the new rate to be
activated.

WARNING

Not all monitors are multi-sync or support all possible
refresh rates. Before you save the refresh settings, be
certain that the monitor that you are using can support
the new refresh rate.

If an incorrect rate is selected, it will not be possible to
display the screen in order to select a different rate. In
that case, attach a monitor that supports the selected
rate, so that you can display the screen and correctly
set a new rate.

Cannot start multiple session on a
serial port.

Cause: Serial Multisession is not
selected as the port type.

Create a session and select Serial Multisession for
the communications port type.
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Table D-2  (Cont.) Troubleshooting: Problems and Solutions

Problem Solution

An attempt to restore lost sessions
does not work.

Cause: The terminal was powered
off or lost connection to the remote
host while in Serial Multisession
mode.

When using a multi-session protocol over a serial line
such as on a terminal server, or when running the
Session Support utility (SSU) on a remote host, if the
connection is lost it might only be possible to recover
one of the sessions at a time.

To recover a session

1. Choose Connection and Restore Sessions.

2. Log out of the connected session.

3. Transfer focus to the next session window.

4. Repeat steps 1 through 3 till all sessions are

closed.

To prevent system operation from stopping, do not
power off the terminal until you close all sessions.
Instead of turning off your terminal, use the following
procedures:

1. Choose the Desktop application from the Control

Panel to select a screen saver.

2. Set a password for the screen saver.

3. Click on the Lock icon in the Control Center to

activate the screen saver.

The screen saver prevents anyone from seeing what
is on your screen or from using your terminal until the
correct password is entered. Once you activate a
password -protected screen saver and turn off your
terminal, the screen saver automatically activates
when you restore power to your terminal.

Cannot find a way to turn on a key
click.

Key click is not supported on the VT LAN40.
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Operating Tips
The following operating tips provide detailed information about optimizing the
use of the copy and paste functions, managing memory, and remapping
keyboard keys.

How to Optimize Copy and Paste
Because the best method for copying and pasting can vary within an application
or between applications, you need to make the following decisions so that your
pasted text is formatted appropriately for the context in which it is being used:

1. Decide whether to use the mouse or the keyboard.

2. Decide whether to copy the text using the block selection or line selection
method explained in this section.

3. Decide the type of paste operation you want to use. The types are:  data,
lines, paragraph, and table.

Note

You can paste the text immediately into the current window at the
present cursor position. Or, you can copy the selected text into the
clipboard and paste it into another session or cursor position.  If you use
the clipboard, you can also paste the same text multiple times until you
perform another copy operation.

Line Selection Method

The line selection method allows you to select across lines of text when you
move the cursor vertically across the lines. Ordinarily, when you paste the line
selected text, carriage returns are not inserted. Even if you select multiple lines,
the entire selection is pasted as a single line of text.

Note

Since no additional space characters are inserted, the last word on a line
may run together with the first word on the following line.

Line selection using the mouse
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Hold down the left mouse button and drag the cursor over the text that you wish
to copy. You cannot copy or paste graphics. If you double click on the left
mouse button, the terminal selects words instead of characters.

Line selection using the keyboard

Select the Edit menu and choose Copy. Use the arrow keys to position the cursor at
the beginning of the text you want to select.  Press and hold the Shift key and use the
arrow keys to position the cursor to a position after the last character of the text.

Block Selection Method

Block selection is useful for copying columns of text or tables from a document.

Block selection using the mouse

Use the right mouse button to select the text you want to copy.  A rectangular
block of text is selected rather than complete lines. Usually when you paste this
block of text, a carriage return is inserted after each line of text.  If you double
click with the right mouse button, the terminal selects complete lines instead of
blocks.

Block selection using the keyboard

Select the Edit menu and choose Block Select. Press and hold the Shift key and
use the arrow keys to position the cursor to a position after the last character of
the text you want to select.

Types of Paste Operations

The Copy Special menu item allows you to customize the type of paste
operation you want to perform: data, lines, paragraph, or table.

• Data: This format is the default used when you "drag select" with the
left mouse button.

Carriage returns are not pasted, and no characters are inserted. This is
useful for copying command lines.

• Lines: This format retains the carriage returns at the end of each line.

No characters are inserted. This is the default when you use the right
mouse button, or when you choose the block selection method using the
mouse or the keyboard.

• Paragraph: This format inserts a space at the end of each line.

Quick Start/Operating Information  D-11



Troubleshooting and
Operating Tips ...

Carriage returns are not retained, and the selection is pasted as a single
line. However, a single carriage return is inserted before a blank line,
and multiple blank lines are treated as one line. This format is useful
for copying text when you use a word processing application.

• Table: This format changes whitespace between words into a single tab
character.

This is useful for pasting text into a spreadsheet application.

Note

Text from the host system will not display until the you have cancelled
the selection. A selection is in effect when the rightmost icon (the Stop
Light) on the Toolbar is red. To cancel the selection, press CTRL-Q or
click on the Stop Light icon.

Additional Copy and Paste Techniques
In addition to the Toolbar and menus, you can use either of the following two
methods to access the copy and paste functions:

Redefine the mouse buttons

The following common customization for the mouse defines the "right mouse
up" event to mean paste. Once redefined, the left mouse button can be used to
select text and the right mouse button can be used to paste text.

1. Select Options Mouse

The Mouse dialog box appears.

2. In the Action area of the dialog box, select "Right button up" from the drop-
down list.

3. In the Map To area of the dialog box, select Paste from the drop-down list.
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4. Choose Done.

You can no longer perform a block select using the right mouse button;
instead use the Block Select menu item.

If there is no visible selected text on the screen, then pressing the right
mouse button pastes whatever text is in the clipboard.

Do not define the mouse button double-click function for pasting. A
double click clears the present selection before performing the paste,
and therefore only works when you are pasting text from the clipboard.

Define a SmartPad button

To use the SmartPad feature, you must enable the Status bar and display the
SmartPad and then define a button, as follows:

1. Choose Options View and be certain that the Status Bar checkbox is
checked.

2. Select Options Show SmartPad.

A checkmark to the left of the Show SmartPad command indicates that the
SmartPad is activated.

3. In the Caption area of the Button Pad dialog box, enter a description such as
'Paste'.

4. In the Map To area of the dialog box, select Paste from the drop-down list.

The new mapping is added to the list of buttons.

5. Turn off the 'X' in front the Buttons on Status Bar option in the dialog box.

You have now created a "floating" SmartPad so that buttons are always
visible.

6. Choose Done.

You can now paste text by clicking the Paste button on the SmartPad.

Quick Start/Operating Information  D-13



Troubleshooting and
Operating Tips ...

Memory Management
The VT LAN40 has a memory pool that is shared between running applications,
such as the VT LAN40 session windows. Each session requires memory and
depletes the pool.

The system resource meter (Sysmeter) provides a visual indication of how much
memory is left in the pool. Sysmeter displays columns with a percentage label
below each column that gives an approximate indication of the percentage of
resources available.

When memory resources are low, Sysmeter automatically displays yellow or red
columns, as follows:

• A yellow column means that 40% of memory is in use.

• A red column means that 90% of memory is in use.

By closing applications that are no longer needed, memory can be restored to
the pool for other applications to use.

Certain settings on the VT LAN40 session window can use large amounts of
memory. For example, under Options History, you can turn on a feature that
stores text that has scrolled off the screen (which you can view by using the
scroll bars on the side of the screen). You can specify a size for maintaining the
history that is less than the default 64K which accommodates 800 eighty-
character lines, or about 33 twenty-four line screens. If you do not need the
default storage amount, or if you do not need to store previously-viewed screens,
you can adjust the settings in the History dialog box and provide more memory
for additional sessions.

How to Remap Keyboard Keys
The VT LAN40 supports two different keyboards. Since common usage for
keyboards differs and keyboard mapping are maintained on a per session basis,
you must define your own key preferences when they key mappings are not
optimum. This section describes the procedures for redefining a key and
provides two examples of how to redefine commonly-used keys.

To redefine a key

1. Select the Options Keyboard menu

The Keyboard Mapping dialog box displays.
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2. When you press a key on the keyboard, the VT LAN40 displays the name
for that key in the PC Key area of the dialog box.

3. Select one of the following options for the Map To area of the dialog box:

• Nothing Make the key inoperative.

• Paste Cause the key to perform the paste function.

• Sequence Allow a key or sequence of keys to be sent to the host
when the key is pressed.

4. Choose Done.

Example 1

On the PC keyboard, the 'dash' (-) key is mapped to the PF4 key. The 'dash' key
can be redefined to mean 'dash' (instead of PF4) as follows:

1. Choose Options Keyboard.

The Keyboard Mapping dialog box displays.

2. Press the 'dash' key on the PC keypad.

The key name appears in the PC Key area of the dialog box.

3. Select Sequence in the Map To area of the dialog box.

4. Choose the Keyboard button.

A small LK411-style keyboard displays.

5. Click on the keypad 'dash' key on the small keyboard.

The Mapped Keys display will read:

Num - [6D] = "<Keypad ->."

6. Choose Done.

The 'dash' key now acts like the LK411 keypad 'dash' key.
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Example 2

If you are using the VT style keyboard (LK411/LK412), it might be helpful to
redefine the 'escape' and the 'angle bracket' keys (< and >) on the left side of the
keyboard.

1. Select Options->Keyboard.

The Keyboard Mapping dialog box displays.

2. Press the 'escape' key on the PC keyboard.

The key name appears in the "PC Key" area of the dialog box.

3. Select "Sequence" in the "Map to" field.

4. Choose the "Keyboard" button.

A small LK411-style keyboard will be displayed.

5. Click on the 'left apostrophe' key ("`") on the small keyboard.

The "Mapped Keys" display will read:

Esc[1B] = "`"

6. Choose the "PC Key" field.

7. While holding down the shift key, press the 'escape' key.

8. On the small keyboard, click on the 'shift' key, then the 'tilde' key ("~").

The "Mapped Keys" display will read:

Esc[1B] = "`"

Shift+Esc[41B] = "~"

9. Follow the same procedure using the 'left angle bracket' (<) and 'right angle
bracket' (>) keys.

The final display will appear as:

Esc[1B] = "`"

Shift+Esc[41B] = "~"

`[C0] = "<"

Shift+`[4C0] = ">"
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Now alternate mappings on the escape key are in effect, and the left and
right angle brackets are available on the angle bracket key, as well as the
shifted comma and period keys.

Note

Outside of a session window, the ESC key still means 'escape' and can
be used to exit from menus and dialogs, etc.

Note

Since the key definitions are in effect only in a session window,
remember that each saved session can have different concurrent
mappings.
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active page

The page that receives data from the host system; the host selects the active
page. The text cursor appears on the active page only. The VT terminal has up
to six pages of display, depending on the selected number of lines per page.

Whether the active page is the current (displayed) page depends on the page you
select to display and whether you allowed page coupling.

active position

The location, indicated by the cursor, where the next typed character will
appear.

active window

The window currently in use.

alias response

A sequence the terminal uses to identify itself to the host as some other type of
terminal. You can configure these responses. Each response corresponds to a
certain operating level.

ANSI

American National Standards Institute.

ANSI character types

The American National Standards Institute graphic (alphanumeric) and control
character type definitions.
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You can display graphic characters on the screen. These include letters,
numbers, punctuation marks, and any other displayable character.

Usually, you do not display control characters. You use them to make the
terminal perform specific functions in data communication and text processing.
Control characters include carriage return (CR), form feed (FF), and escape
(ESC).

ANSI terminal specification

The American National Standards Institute specification for terminal
functionality. VT terminals implement many of the functions and extensions to
the functions that are defined in this specification. VT LAN40 implements the
VT ANSI features and extensions, and numerous extensions of its own.

application software

A program that performs a specific function, such as VT LAN40 emulation.

application window

The screen area (window) containing the work area, and associated information
displays, such as a menu bar. The application window contains the title bar and
menu bar on the top, the emulation window in the center, and the status bar on
the bottom.

argument

The numbers, text, or graphics that refine the action or result of a macro
function.

array

A table of related variables.

ASCII

American Standard Code for Information Interchange.

attribute

A font style you can assign to a character such as bold or italic; a size (height or
width) you can assign to a line.
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Auto Print

A mode, controlled by the host in which data appears on the screen and the
printer.

backing store

A VT LAN40 feature that provides two methods of storing graphics images:
Bitmap and Display List.

BAUD rate

The speed, measured in bits per second, at which the terminal communicates
with the host system or a printer.

bitmap

An array of pixels representing an object (image).

bottom margin

The last line of the scrolling region.

buffer

A temporary storage area in memory used to hold information.

button pad

An area of the window that contains a display of user-defined buttons. You can
create a button pad to display on the status bar or in a separate window.

C0 and C1 codes

The control characters in the 256-character set used by VT terminals. The set
consists of two halves, lower and upper, each containing 128 characters. The
first 32 characters of the lower part are the C0 codes; the first 32 characters of
the upper part are the C1 codes.

CCITT

Comité Consultatif Internationale de Telegraphie et Telephonie. An
international organization that defines standards for communications equipment
such as telephones and telegraphs.
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character attribute

A characteristic (format) assigned to a character that determines how the
character appears on the screen. Character attributes include bold, italic,
underline, and so on.

character set

A group of graphic and control characters stored as a unit in the terminal. You
can display graphic characters on the screen. You use control characters to
perform special functions.

character-coding format

The coding formats for characters: 7-bit coding uses 7 bits to send each
character to the host system, 8-bit coding uses 8 bits. The ASCII character set
uses 7-bit coding; the Multinational and ISO character sets use 8-bit coding.

client

An application or system that requests services or resources from another
application or system.

code table

A list of all characters in a character set and their codes. Most standard character
sets put similar characters into groups, so they have similar codes.

columns

A vertical row of character positions on the screen. You can display lines
containing 80 or 132 columns.

configure

The process of selecting options that determine the characteristics and the
appearance of application and emulation windows, and features such as Auto
Start and Communications.

constant

A fixed value that does not change during macro execution.

GL-4  Quick Start/Operating Information



Glossary ...

control codes

The codes that specify terminal commands or formatting instructions such as LF
(line feed) or CR (carriage return); usually, preceded by a caret (^ ).

control functions

The commands an application uses to make the VT LAN40 perform special
functions. These include control characters, device control strings, control
sequences, and escape sequences.

coupling

A function that keeps the cursor visible when you pan beyond the window edges
in a particular direction. You can couple the cursor to horizontal or vertical
movement, or to display a different page when the cursor moves to it in
memory.

CSI code

Control Sequence Introducer code. The control function used to start most ANSI
commands. You can transmit CSI as the two 7-bit characters ESC [, or the
single 8-bit character CSI (9B hex).

CTERM

The wide area DECnet network.

current page

The displayed page. See also Active page.

cursor

The indicator of the active position on the screen. The text cursor usually
appears as a blinking underline or block; the mouse cursor usually appears as an
I-bar symbol.

data bits

The number of bits (7 or 8) in each data packet sent between two computers.
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DDE

Dynamic Data Exchange. Windows-defined protocol for transferring data
between Windows applications. The VT LAN40 supports DDE as a server and a
client.

DEC Multinational Character Set

A character set consisting of two parts: 7-bit (left half), and 8-bit (right half).
Each half contains its own control characters.

DEC Special Graphics Character Set

A 7-bit character set of 94 graphic characters including special symbols and line
segments. Also called the VT100 Line Drawing character set.

DEC Supplemental Graphic Character Set

An 8-bit character set of 94 graphic characters including letters with accents and
diacritical marks, and special symbols.

DEC Technical Character Set

A 7-bit character set containing scientific and mathematical characters used to
write formulas and equations, including the Greek alphabet.

desktop

The background of your screen on which windows, icons, and dialog boxes
appear.

device attributes

The characteristics, stored as control sequences, that describe the terminal and
its configuration. A request from the host to the terminal sends a device attribute
(DA) response. This DA response identifies the particular type of terminal.

dialog box

A window that displays options for you to choose to give the application the
information it needs to carry out a command.

display controls mode

A special operating mode in which you can display control characters. In this
mode, VT LAN40 does not perform any control functions, but only displays the
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characters. This mode is controlled by the Transparent option in the Display
dialog box (Options Terminal menu).

display list

A set of instructions for drawing an object (image).

echo

The display data sent to the host system on the screen as you type. If the host
does not send back the characters it receives, you should select the Local Echo
mode option in the Terminal General dialog box (Options Terminal menu).

emulation

A mode in which a device imitates the behavior of a different device.

emulation window

The area of the application window containing the VT terminal face, scroll bars,
and VT status line. Usually, the emulation window entirely fills the application
window. When it does not, there is a border around the emulation window.

flow control

The processes that regulate the rate at which data is transferred from one device
to another. This process compensates for the differences in input and output data
flow.

font set

A group of fonts designed used with a specific device resolution. The set used
determines how the text looks on the screen and printer.

font size

The height of a printed character; also called point size. One point equals 1/72
of an inch.

font styles

The format that you can assign to characters—bold, underline, italic, normal, or
combinations of these. Also called text styles, attributes, and type styles.

Quick Start/Operating Information  GL-7



Glossary ...

full-duplex

A communications mode in which the signal flows in both directions at the same
time, enabling you to transmit and receive data simultaneously. VT LAN40
normally operates in full-duplex mode.

function keys

A row or rows of keys that perform special local functions, such as displaying
Help.

graphic table

The terminal  in-use table that is formatted two-parts: the left half contains the
GL codes for use in 7-bit or 8-bit environments; the right half contains the GR
codes for use in 8-bit environments only.

half duplex

A communications mode in which the signal flows in both directions, but only
one direction at a time.

history

A VT LAN40 feature that allows you to store information that is no longer
displayed because it scrolls off the screen.

history buffer

A temporary storage area where you can keep data no longer displayed in the
emulation window. You can view, copy, and paste this data.

HoldScreen key

A key that causes output to the screen to pause until you press the Holdscreen
key again. On the IBM Enhanced keyboard, F1 functions as the Holdscreen key.

host system

The computer system to which the VT LAN40 connects.

ISO

International Organization for Standardization.
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ISO Latin-1 Supplemental Set

An 8-bit character set including letters with accents and diacritical marks, and
special symbols. For most purposes, this set is an extension of the Multinational
character set.

LAN

Local Area Network.

LAT

Local Area Transport. The network protocol for terminal access using Ethernet.

layout file

A file that stores information about a group of VT LAN40 application windows,
their positions on the desktop, and their host connections.

line attributes

The characteristics (formats) that you apply to a line to change the way it
displays on the screen. The VT LAN40 supports the same line attributes as
VT terminals: double-wide, double-high and double-wide, and normal.

line drop

An unrequested communications disconnection. Most network connections have
built-in functions to indicate a broken connection. The VT LAN40 generally
notifies the user when this happens.

local area network

See LAN.

local area transport

See LAT.

local mode

An operating state in which keystrokes are displayed on the screen, but not sent
to the host.
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local edit

An editing mode in which the VT LAN40 stores text you type in page memory.
You can edit this text in the VT LAN40, and then send a block of edited text to
the host.

map

The process of assigning sequences and VT functions to keyboard keys, mouse
buttons, and user-defined buttons.

margins

The top, bottom, left, and right boundaries of a page. The VT LAN40 cannot
write or scroll data beyond these margins. Also called scrolling margins.

menu bar

A horizontal bar in the application window that contains the names of the
VT LAN40 menus; appears below the Title bar.

modem

A communications device that transmits and receives data over a telephone line.

MSU

See Multisession Serial Utility.

Multisession Serial Utility

Multisession Serial Utility is an implementation of the SSU Utility for providing
multiple sessions on a single serial line.

NRC

See National Replacement Character Sets.

National Replacement Character Sets

A class of 7-bit character sets created for different languages and dialects.
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on-line

An operating state in which VT LAN40 can communicate with a host system.
The VT LAN40 sends data entered at the keyboard to the host, and displays data
received from the host on the screen.

page

A section of the terminal page memory. Each page has left, right, top, and
bottom scrolling margins. You can define the size and layout of a page by using
setup features or control functions.

page format

The size and number of pages in the terminal page memory. You can arrange
page memory into 1 to 6 pages. You also can define the margins of a page.

page memory

An area in memory that stores the information on the screen. You can divide
page memory into a variable number of pages each containing the same number
of lines.

pan

The action of moving the page behind the window. This page movement allows
you to view information not displayed in the window when the page is larger
than the window. To pan the page, use the horizontal and vertical scroll bars.

parallel port

A port used for devices that accept information one 8-bit word at a time; uses
multiple lines to transfer data.

parity

An error detection method that checks the validity of a transmitted character;
both systems must use the same type of parity.

pixel

The smallest displayable unit on a video screen; also called pel, or picture element.
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port

A connection or socket used to attach a device, such as a printer or modem, to
your PC. Your PC sends information to the attached device through a cable.

print buffer

A temporary storage area for information to be sent to a printer.

printer controller mode

A mode in which data is sent directly from the host to a printer, without
displaying it on the screen.

protocol

A set of rules and procedures for communication between devices. For example,
Kermit is a file transfer protocol, and XON/XOFF is a flow control protocol for
serial communications.

ReGIS

Remote Graphics Instruction Set. A set of commands that describes a graphics image
using geometric shapes (lines, curves, and circles), and actions (fills and patterns).

Remote Graphics Instruction Set

See ReGIS.

resolution

The number of dots that make up an image on a screen or printer. The more
dots, the higher the resolution, and the finer and smoother images appear when
displayed at a given size.

scrolling

The moving of data between the margins of the current page. Data that scrolls
past the margins does not remain in page memory, but you can save it in the
History Buffer.

scrolling region

The area on the current page between the top, bottom, left, and right page
margins. The default scrolling region is the complete page.
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select

The process of marking a section of text for copying. You can mark lines or
blocks of text with the mouse or keyboard.

serial port

A port used for devices that accept information one bit at a time; uses a single
line to transfer data.

server

A system or application that provides shared resources (such as printers) and
services to other computers and applications.

session

An active connection between VT LAN40 and a host system. You can run VT
LAN40 in multiple application windows, each window containing a session with
the same or a different host.

Session Support Utility

See SSU.

7-bit and 8-bit codes

The coding formats for characters; 7-bit coding uses 7 bits to send each
character to the host system, 8-bit coding uses 8 bits. The ASCII character set
uses 7-bit coding; the Multinational and ISO character sets use 8-bit coding.

Sixel

A unit of graphics data transmitted as a character. One Sixel represents six
vertical pixels of an image.

SmartPad

See Button Pad.

spooler

A system program that automatically runs when you choose a print command.
The spooler allows you to print a series of documents or files in the background
while you continue working in the application.

Quick Start/Operating Information  GL-13



Glossary ...

SSU

Session Support Utility. A mechanism that provides multiple sessions on a
single serial line.

stop bit

A timing unit between transmitted characters.

string

A sequence of alphanumeric characters.

subscript

A string or integer used to access an item in an array.

Supplemental Character Set

The 8-bit character set the terminal normally uses; usually, the Multinational, or
ISO Latin-1 character set.

System Resource Monitor

The System Resource Meter allows you to monitor some of the memory
resources of your terminal.

Tektronix 4014

A vector graphics terminal that uses direct-view storage tube technology.

Telnet

A protocol for terminal access to hosts using a TCP/IP network connection.

terminator

A control character(s) that signal the end of a line, document, and so on.

Toolbar

A row of icons in your session window that represent the VT LAN40 commands
that are available from your desktop window.
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transparent mode

A special operating mode in which you can display control codes characters.
In this mode, the VT LAN40 does not perform any control functions, but only
displays the characters. This mode is controlled by the Transparent option in the
Display dialog box (Options Terminal menu).

User-Defined Keys (UDKs)

On VT terminals, fifteen of the top row keys defined on the keyboard as User-
Defined Keys. You can use UDKs to send selected characters or control
functions. You  use UDKs as Shift+F6 through Shift+F20. Normally, the Host
computer assigns these keys.

VESA

Video Electronics Standards Association.

VT status line

A line of text that appears below the VT LAN40 emulation window. There are
three possible settings: indicator (displays operating information about the
VT LAN40), host-writable (displays information provided by an application),
and disabled.

XON/XOFF

The standard ASCII control characters used to tell an intelligent device to stop
and resume transmission of data.

zoom

The process of increasing or decreasing the magnification of an object (image).
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A
Acoustic noise conformance, C-6

Active window, 2-3

ALT + letter, keyboard shortcut, A-4

Applications, sharing memory, 1-1

Asbestos compliance, C-8

Attribute, default color, 3-6

Auto connect command, B-8

Auto Print, 5-5

Auto Start, 1-8

B
Backspace key, 3-16

Battery disposal, C-8

Battery replacement, C-8

Baud rate, B-10

Bitmap, 5-10

Block command, 4-5

Block select command, 4-2

C
Calculator, 1-2

Calendar, 1-2

Character set mode, 3-11

Choose

a command button, QS-8

carry out an action, A-2

item from a menu, A-2

select before choosing, A-2

Clear history command, 3-20

Click, mouse technique, A-1

Close a window, A-14

Close print command, 2-12

Close print job, 2-7

Color

emulation, 3-6

exact, 3-7

index, 3-7

lock color, 3-8

range of display, 3-6

ratio, 3-7

reset, 3-8

reverse foreground and
background, 3-15

screen background, 1-3

COM ports, B-10

Command conventions

checkmark, A-6

dimmed command, A-6

ellipsis, A-6

key combinations, A-6

triangle, A-6

Communications
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auto connect command, B-8

clear communications buffers, B-8

connect command, B-8

control session, B-7; B-8

disconnect command, B-8

overview, B-4

port configuration procedures, QS-5; B-5

setup, B-6

slowing transmission rate, B-6

Communications method

networks, B-4

ports, B-4

Compose character, C-5

Configuration

Auto Start, 1-8

communications, B-4

customizing, 1-5

display list, 1-9

first-time keyboard setup, QS-1

first-time network setup, QS-2

options, 1-6

save changes, 3-21

Configuration options, 1-2

Connect command, B-8

Control Center

application icons, 1-2

startup, 2-1

Control menu

commands  A-, A-8

open, A-7; A-8

use, A-6

Control Panel, 1-2

Controlling session with your
host, B-7; B-8

Copy

data, 4-4

lines, 4-4

paragraph, 4-4

table, 4-4

Copy command, 4-2

Copy special command, 4-2

Copy type option, 4-2; 4-3

CTERM

port setup, B-5; B-6

port type, QS-5

Cursor key, 3-16

Customize

configuration options, 1-5

menu bar, 3-23

D
Data bits, B-10

DCD signal, B-11

DECnet

connection, B-3

setup, QS-2

Defining a SmartPad button, 3-21

Defining buttons, 3-3

Desktop, 1-1

Device attributes (DA), 3-10

Dialog box

checkboxes, A-20

command buttons, A-16

command followed by ellipsis, A-16

drop-down list box, A-19

list boxes, A-18

moving within, A-16

option buttons, A-20

options for changing information, A-17

text boxes, A-17

use, A-15

Disconnect command, B-8

Display command, 3-12

Display list
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configuration option, 1-9

graphics printing option, 5-4

printing procedures, 5-3

Display options

auto wrap, 3-14

color attributes, 3-15

colors, 3-15

columns, 3-13

cursor display type, 3-14

lines per page, 3-13

new line, 3-14

scroll, 3-14

scrolling, 3-14

status, 3-14

Double-click, mouse technique, A-1

Drag, mouse technique, A-1

DSR signal, B-11

DTR signal, B-11

E
Echo handling, 3-12

Edit menu

block select, 4-1

copy command, 4-1

copy special command, 4-1

select command, 4-1

using emulation window, 4-1

Elements of a window

active window, 2-3

functions, 2-2

insertion point, 2-3

maximize button, 2-3

menu bar, 2-3

minimize button, 2-3

mouse pointer, 2-4

restore button, 2-3

scroll bars, 2-4

title bar, 2-3

Toolbar, 2-3

window border, 2-4

Ellipsis, A-6; A-15

Emulation

block selecting text, 4-2

copy function, 4-2

copy special window, 4-2

paste function, 4-2

selecting text, 4-2

window, 4-1

Enlarge font, 3-5

Enlarge window, A-12

Ergonomic requirements, C-7

Error checking, B-10

Exit all command, 2-12

Exit session command, 2-7; 2-12

Exit settings command, 3-20

F
Flame retardants, C-7

Flow control, B-10

Fonts

for printing, 5-10

options for printing, 5-11

resolution, 3-4

Form feed, 5-7

G
Graphics

bitmap storage, 3-18

display list, 3-18

other printing options, 5-4

printing, 5-3
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H
Hardware

configuration setup, B-6

setting parameters, B-6

Hardware flow control, B-10

History

clear history, B-8

clear history command, 3-20

enable history, B-8

session overview, 3-19

view stored, 3-19

I
Insertion point, 2-3

ISO color sequences, 3-6

K
Keyboard, C-5

command, 3-15

editpad, 3-16

mapping, 3-17

mode, 3-16

options, 1-3

overview of layout, 3-15

style, C-5

type, 3-16

VT keyboard button, 3-25

Keyboard command aids, A-2

Keyboard mapping, 3-22

Keyboard requirement, C-5

Keyboard shortcut

ALT + letter, A-4

underlined letter, A-4

L
Language

display, 3-6

options, 3-6

LAT

port setup, B-5; B-6

port type, QS-5

Layout

previously saved, 2-16

saving for multiple sessions, 2-15

Login, QS-6

Logout, QS-7

M
Maximize button, 2-3

Memory requirement, C-5

Memory, system resource monitor, 1-4

Menu bar

customize, 3-23

window element, 2-3

Menus

choose a command, A-3

choose an item from a menu, A-2; A-5

close a menu, A-4

control menu, A-6

control-menu box, A-6

menu bar list, A-2

menu item conventions for
commands, A-6

select a menu, A-3

select a menu using a mouse, A-3

select a menu using the keyboard, A-4

Minimize button, 2-3

Monitor, C-5

Mouse

assign characters to buttons, 3-24

assign functions to buttons, 3-24
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change defaults functions, 3-24

Mouse command, 3-24

Mouse pointer, 2-4

Mouse techniques

click, A-1

double-click, A-1

drag, A-1

point, A-1

Multinational character set, 3-11

Multiple sessions

overview, 2-5

port setup, QS-5

switch between open sessions, 2-10

Multisession, See Multiple sessions

N
National Character Replacement Set, 3-12

Networks

DECnet, QS-2

for communications, B-4

setup, QS-2

TCP/IP, QS-2

type of service, B-6

Next session command, 2-14

NRC, see National Replacement
Character Set

O
Open layout command, 2-14; 2-16

Open session, 2-4

Open session command, 2-9

Options

character set mode, 3-11

color mapping, 3-2

defining menus, 3-3

device attributes (DA), 3-10

display command, 3-12

display window characteristics, 3-2

emulation window display, 3-3

for terminal print command, 5-7

keyboard command, 3-15

keyboard layout, 3-15

keyboard mapping, 3-3

keyboard settings, 3-3

mouse functions, 3-3

port setup, 3-3

printer command, 3-19

printing control, 3-3

show keyboard, 3-4

show keyboard command, 3-24

show SmartPad, 3-4; 3-24

show Toolbar, 3-4; 3-24

SmartPad, 3-3

storage of session history, 3-3

terminal emulation characteristics, 3-3

terminal type, 3-3

VT local editing, 3-3

Options menu, 3-2

Options menu colors, 3-6

Options menu exit settings, 3-20

Options menu history, 3-19

Options menu keyboard, 3-21

Options menu menus, 3-23

Options menu mouse, 3-24

Options menu SmartPad, 3-21

Options menu terminal commands, 3-8

Options menu view, 3-4

Ozone compliance, C-8

P
Parity, B-10

Password, 1-10

Paste, 4-5

Paste command, 4-2; 4-4
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Point, mouse technique, A-1

Ports

COM, B-10

communications method, B-4

settings for startup, QS-5

specifying, 1-3

Power cord information, C-9

Print

all pages, 5-7

bitmap graphics, 5-10

controller mode, 5-10

fonts, 5-10

graphics background, 5-10

graphics colors, 5-10

graphics palette background, 5-10

page(s), 5-7

selection, 5-7

window, 5-7

Print command

button, 5-7

form feed, 5-7

format, 5-7

overview, 5-6

specifying printing, 5-7

Print data

close print job, 5-5

delete buffered, 5-5

timer controls, 5-5

Print mode options, 5-8

Print setup, 2-7

Print setup command, 5-1

Printer

driver, 1-4

timer, 5-9

Printer  command, 3-19

Printer control mode, 5-5

Printing

ANSI printer, 5-5

autoprint, 5-5

format, 5-7

from the display list, 5-3

graphics, 5-3

options, 5-2

overview, 5-1

procedures, 5-2

text, 5-2

using print button, 5-2; 5-4

Printing functions, 5-1

Proper setup and use, C-1; C-2; C-3

PVC compliance, C-8

R
Radio noise emission limits, C-7

Reduce font, 3-5

Reduce window, A-11

Resolution, 3-7; 3-8

Restore button, 2-3

Restore factory settings, 1-10

S
Save As command, 2-11

Save command, 2-11

Save layout command, 2-14; 2-15; 2-16

Screen

background, 1-3

saver, 1-2

Scroll bar

horizontal, 2-4

techniques for scrolling, A-13

use, A-13

vertical, 2-4

view vertical, 3-5

Scroll bar box

view horizontal, 3-5; 3-6
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Security

set password, 1-10

setup, 1-10

Select

before choose, A-2

checkbox in a dialog box, A-2

highlight an item, A-2

item in a window, A-2

Select command, 4-2; 4-5

Serial multisession port, B-6

Serial port

setup, QS-5; B-5; B-10

single session, B-4

Serial port communications, B-5

Session

close print job, 2-7

close print job command, 2-12

connect, 2-10

disconnect, 2-11

exit all command, 2-12

exit all sessions, QS-7; 2-7

exit one session, QS-7; 2-7

exit session command, 2-12

first-time startup, QS-3

list, 2-17

menu, 2-6

multiple, 2-5

new, 2-8

open session, 2-9

other save options, 2-11

overview, 2-5

print command, 5-6

print setup, 2-7

print setup command, 5-1

save command, 2-11

select existing session, 2-10

setup, 2-8

switch between open sessions, 2-10

view session history, 3-19

Set resolution, 1-4

Setup hardware configuration, B-6

Sharing computer memory, 1-1

Show keyboard command, 3-24

SmartPad, 3-3

Specifications

battery disposal, C-8

battery replacement, C-8

keyboard, C-5

monitor, C-5

power cord information, C-9

standards conformance and
approvals, C-6

system unit, C-4

Standards conformance and
approvals, C-6

Startup

Control Center, 2-1

first time, QS-3

Status bar, display, 3-6

Stop bits, B-10

System resource monitor, 1-4

System unit, C-4

T
TCP/IP

connection, B-2

setup, QS-2

Telnet

port setup, B-5; B-6

port type, QS-5

Terminal

commands, 3-8

emulation settings, 3-10

operating mode, 3-10
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print mode options, 5-8

Title bar, 2-3

Toolbar, QS-6; 2-3; 3-24

Toolbar use

copy, QS-8; 2-4

display colors, QS-8; 2-5; 3-7

enlarge font, QS-8; 2-5; 3-5

function icons, QS-8

hold screen, QS-8; 2-5

next session, QS-8; 2-5

open session, 2-4

paste, QS-8; 2-4

print, QS-8; 2-4

reduce font, QS-8; 2-5; 3-5

show keyboard, QS-8; 2-5

Transmission rate

limiting, B-6

U
UDKs, See User-defined keys

Underlined letter, keyboard shortcut, A-4

User preference settings, 3-12

User-defined keys, 3-12; 3-17

User-preferred character set, 3-11

V
VESA requirements, C-8

VGA, 3-5

VGA support, C-5

View options

display status bar, 3-6

font size, 3-4

horizontal scroll bar, 3-5; 3-6

language, 3-6

vertical scroll bar, 3-5

VT

Control Center, 2-1

Printing functions, 5-1

W-Z
Window

close, A-14

enlarge, A-12

reduce window to an icon, A-11

sizing, A-9; A-10

Window border, 2-4

Window elements

active window, 2-3

functions of, 2-2

insertion point, 2-3

maximize button, 2-3

menu bar, 2-3

minimize button, 2-3

mouse pointer, 2-4

restore button, 2-3

scroll bars, 2-4

title bar, 2-3

Toolbar, 2-3

window border, 2-4

Window menu, 2-13

Windows

colors, 1-3

date and time format, 1-4

desktop screen space, 1-1

keyboard, 1-3

mouse techniques, A-1

ports, 1-3

printer driver options, 1-4

resolution settings, 3-7; 3-8

sharing computer memory, 1-1

Xoff point, B-10

Xon/Xoff, B-10
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